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1 Introduction

This document provides information about the authorization settings in the Authorizations window in SAP
Business One. For more information about the authorization function, see the online help for SAP Business
One.

In the Authorizations window, you can determine the required authorizations for the users and user groups in
your company.

You can also grant authorizations for creating, updating, and deleting documents in the Data Ownership
Authorizations window. Only a user defined as Superuser (| Administration » Setup » General » Users »
Setup ) can access the Authorizations submenu and grant authorizations for other users.

A user defined as a Superuser has full authorization for all SAP Business One modules and functions and it is
not possible to modify the authorizations for this user.

Within a module, when different components have different authorizations, the module authorization is
displayed as Various Authorizations. For example, in the Sales module, if you have Full Authorization for the
sales quotation, but No Authorization for the sales order, Sales is displayed as Various Authorizations.

This document relates to a Professional User license. Other license types have a fixed set of authorizations.
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2 Authorizations Window

The main pane of the Authorizations window contains a list of modules and functions. To expand its content,

choose P nextto a module or a function name.

The column to the right of the function names displays the authorization type granted for the module, window,
function, or action.

i Note

In the Authorizations window, the functions appear in a hierarchical structure. The Expand icon ( * )ina
row indicates that the function contains additional functions at a lower level. The authorizations set at the

higher level apply to all its lower level functions. To set each lower level function individually, choose F to
expand the hierarchy and set the authorizations for the specific function.

To open the Authorizations window, proceed as follows:
From the SAP Business One Main Menu, choose |# Administration ¥ System Initialization j Authorizations ¥
General Authorizations 3.

You can define the authorizations for either an individual user, or a group of users with Authorization group
type.

2.1 Authorizations for Users

To define authorizations for a user, select the user on the Users tab on the left side of the window,

You can select the Hide Locked Users checkbox to hide users for whom the Locked checkbox is selected in the
Users - Setup window.
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[7] Hide Locked Users
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EDsUser - EDslUser } Customization Toolks Full A '
manager - manager } Administration Full A
= -~ A P} Financizls Fu
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P} Purchasing - &/P Fu
P Business Partners Fu
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Mz, Discount - General 100,00
Masx, Cash Amount for Incoming Payments
Full Authorization Read Onby No Authorization

Defining Authorization Profiles for a Certain User

In the Authorization column, select one of the following options for the corresponding subject displayed in the
Subject column:

e full Authorization: grant full authorizations to the user for the subject
® Read-Only: the user can display all data of the subject but cannot make any changes to it
e No Authorization: the user is unable to display or change any data of the subject

Effective Authorization for a User

This column displays the resultant authorization that the current user has over the subject. It is the highest
level of authorization that is applied to the user considering the authorization defined for it and the user group
or groups it belongs to.

o Example
User UOOOQ1 is assigned to User Group A and User Group B. For a particular permission subject:

e UOOO1 authorization = Read-Only
e User Group A authorization = Full Authorization
® User Group B authorization = No Authorization

As a result, the effective authorization = Full Authorization.

i Note

The authorizations at the window level have the highest priority over those at the field,tab or other sub-
levels. When a specific window is inaccessible to a user, the user cannot access any elements of the
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window, unless the user has the authorization of an authorized user and can provide credentials of the
authorized user in the Permission override window that pops up.

2.2 Authorizations for User Groups

To define authorizations for a user group, select a user group on the Groups tab on the left side of the window.

[7] Hide Locked Users
J Users Groups Find MNext
AlertSvc - AleriSvc Subject Authorization Effective Authorization A
Bli - BLi P Genersl Full Authorization Full Authorization -
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Warkflow - Werkflow P Szles- AR Full Authorization | Full Autherization
» Purchasing - AP Full Authorization Full Authorization
} Business Partners Full Authorization Full Authorization
P Banking Full Authorization Full Authorization
P Inventory Full Authorization Full Authorization
P Rescurces Full Authorization Full Authorization
} Production Full Authorization Full Authorization
| ™| » MRP Full Authorization Full Authorization =
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[] Max. Cash Amount for Incoming Payments
Full Authorization Read Onby Mo Authorization

Defining Authorization Profiles for a User Group

In the Authorization column, select one of the following options for the corresponding subject displayed in the
Subject column:

e full Authorization: grant full authorizations to all users in the group for the subject

e Read-Only: all users in the group can display all data of the subject but cannot make any changes to it

e No Authorization: all users in the groupare unable to display or change any data of the subject
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2.3 Copying Authorization Profiles from One User to

Another

Prerequisites

Ensure that the users are already defined in the company.

i Note

For more about defining users, see the online help.

Context

After defining the general authorizations for a certain use, you can copy his or her authorization profile to
another user.

Procedure

To copy authorizations to multiple users:

1

S T

In the Authorizations window, on the left side, select a user who has the authorizations that you want to
copy.

i Note

To check the authorizations for specific users, select a user and in the Authorization column, the
permissions for the selected user are displayed.

Drag and drop the user name onto the name of the user to whom you want to copy the authorizations.
In the System Message window, choose Copy.
Choose Update, then choose OK.
The second user now has the same authorizations as the first.
The following behavior applies when changing authorizations in SAP Business One:
o When you change the authorization of a parent article, for example, from No Authorization to Full

Authorization, the change is applied automatically to all the child authorizations below it.

o If you change the parent article to Read Only, and one or more of the child authorizations do not
include the Read Only option, this child authorization is set with the value No Authorization.

o When you change an authorization that has a parent article, and that parent article represents an
application window (for example, the authorization for the Business Partner Master Data window under
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Business Partners in the authorizations tree), the parent article is not influenced and retains the same
authorization it had before the child authorization was changed.

o When you change an authorization that has a parent article, and that parent article represents a menu
entry in SAP Business One, but with no application window (for example, Setup, under Administration
in the Authorizations tree) the following behavior applies:

o If after the change of the child authorization, the values of the child authorizations below the
specific parent article vary (for example, one child authorization is set to No Authorization and the
other is set to Full Authorization), the parent article is set with the value Various Authorizations.

o |f after the change of the child authorization, all of the child authorizations of a specific parent
article are set to the same value, the parent article is set to that value as well.

How to Define Authorizations in SAP Business One 10.0
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3 General Authorizations

The following modules and functions define the general authorizations:

Field Name

Description

General

Full Authorization: Users can enter all General functions and make required changes or
new settings.

Read Only: Users can view the data defined in all the General functions.

No Authorization: Users cannot access any option specified in the General functions.

i Note

If you select the Read Only authorization for the entire list of General functions, the au-
thorizations for its child items without the Read Only option are automatically set to No
Authorization.

Send Message

Full Authorization: Users can open the Send Message window (|} File > Send > Send

Message 1 and send messages.

Read Only: Users can open the Send Message window but cannot send messages.

i Note

Authorization for document printing is required to send documents as e-mail at-
tachments. The e-mail layout is defined in the document's printing properties.
To save a distribution list when sending e-mails or SMS messages, authorization

for the document settings (|} Administration > System Initialization }) is required.
The Read Only authorization gives users the ability to view a saved distribution list.
With full authorization, users can save a new distribution list.

No Authorization: Users cannot open the Send Message window.

Print Layout Designer

Full Authorization: Users can use the Print Layout Designer functions, such as modify-
ing existing print templates and creating new print templates, for sales and purchasing
documents.

No Authorization: Users cannot use the Print Layout Designer functions.

Change Default Report

Full Authorization: Users can layout change the default print currently defined for a cer-
tain document or report.

No Authorization: Users cannot change the default print layout currently defined for a
certain document or report.
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Field Name Description

Query Print Layout ® full Authorization: Users can open the Query Print Layout window and modify the user-
defined query print template.

i Note

To open a template, you need authorization for Print Layout Designer.

To print the query, you require authorization in the Sales module for document
printing.

To create a new query print layout, you require Read Only or Full Authorization for
the query generator, query manager and for Saved Queries: Group No. 1, 2, and so
on.

® No Authorization: Users cannot open the Query Print Layout window.

Form Settings o Full Authorization: Users can open the Form Settings window (| Tools * Form

Settings }) and modify data. For example, users can determine which columns to be
displayed, determine whether the columns will be active or not, or change the system
default values for fields such as Sales Employee, Price List and Discount.

i Note
To modify the Sales Employee field in a marketing document through Form Set-
tings (or directly in the document) when adding the document, authorization for

|} Sales - A/R > Change Sales Employee ] is required.

To update the Sales Employee field through Form Settings when updating a mar-
keting document, authorization forl) Sales - A/R > Sales Employee Update } is

required.

The Price List dropdown list in Form Settings displays only price lists in the price list
group for which you have read only or full authorization.

To set a discount in Form Settings (or directly in the document header or document
row), you must first define the Max. Discount - Sales value and/or the Max.
Discount - Purchase value in the Authorizations window.

e No Authorization: Users cannot access the Form Settings window (|} Tools > Form

Settings ]).

How to Define Authorizations in SAP Business One 10.0
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Field Name Description

Access to Confidential °
Accounts

Full Authorization: Users can view G/L accounts marked as Confidential (|} Financials
> Chart of Accounts > Confidential ] field); you also must have Read Only or Full
Authorization rights for the chart of accounts.

No Authorization: Users cannot view confidential G/L accounts in the chart of accounts
orin any report that displays G/L accounts. In addition, confidential G/L accounts are
not displayed in any Choose From lists displaying G/L accounts.

i Note

Users without authorizations for confidential accounts but with authorizations for jour-

nal entries/documents can view journal entries/documents posted to the accounts.

Account Balances °

Full Authorization: Users can view the balances of G/L accounts in the chart of ac-
counts and generate reports with account balance data; you also must have Read Only
or Full Authorization rights for the chart of accounts.

No Authorization: Users cannot view data about G/L accounts in financial reports, such
as the General Ledger report.

BP Balances °

Full Authorization: Users can view the balances of business partners displayed in the
Business Partner Master Data window and in the Account Balance window. You also re-
quire Read Only or Full Authorization rights for business partner master data. To open
the account balance from a sales document, you need full authorization for the sales
order and delivery.

No Authorization: Users cannot view data for business partners or in financial reports
such as the General Ledger report. In addition, the Account Balance field in the Business
Partner Master Data window displays asterisks (****) instead of the actual balance.

i Note

If

users have no authorizations to view business partner balances, you must also pre-

vent them from viewing the following:

All documents and reports related to the business partner by which the balances
can be concluded, including marketing documents, journal entries and transaction
journals.

Accounts balances (chart of accounts) by which the business partner balances can
be concluded when the accounts transactions that involve business partners can
be viewed.

How to Define Authorizations in SAP Business On
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Field Name

Description

Access to Masked Data

Full Authorization: Users can view and modify the masked data.
Read-Only: Users can view but cannot modify the masked data.

No Authorization: Users can view but cannot modify the masked data.

Available in Korea only:

Full Authorization: Users can view and modify the actual values of the masked data.
Read-Only: Users can view but cannot modify the actual values of the masked data.

No Authorization: Users can view fully/partially masked data only.

Employee ID No.

Full Authorization: Users can view and modify the Employee ID No.
Read-Only: Users can view but cannot modify the Employee ID No.

No Authorization: Users can view but cannot modify the Employee ID No.

Employee Passport No.

Full Authorization: Users can view and modify the Employee Passport No.
Read-Only: Users can view but cannot modify the Employee Passport No.

No Authorization: Users can view but cannot modify the Employee Passport No.

BP ID No. 2

Full Authorization: Users can view and modify BP ID No. 2.
Read-Only: Users can view but cannot modify BP ID No. 2

No Authorization: Users can view but cannot modify BP ID No. 2.

Unformatted Text

Full Authorization: Users can export data in XML format. You also require authorization
for the relevant functions and documents.

No Authorization: Users cannot export data in XML format.

MS—-EXCEL

Full Authorization: Users can export data to Microsoft Excel. You also require authoriza-
tion for the related functions.

No Authorization: The Export to Microsoft Excel (E]) icon and the |} File > Export >
MS-Excel 4 menu are disabled.
i Note

If you have no authorizations except for Export to MS-Excel, only the main menu
and the MS Excel icon are active when you open SAP Business One. Note that the
main menu is not exported to MS Excel

MS-WORD

Full Authorization: Users can export documents, letters, and reports to Microsoft Word.

No Authorization: The Export to Microsoft Word () icon is not active for you.

Copy Table

Full Authorization: Users can use the Copy Table function on all documents, records,
and reports in which the copy table function is available (right click a cell in the table

and choose Copy Table or, in the menu bar, choose |+ Edit # Copy Table ).

No Authorization: Users cannot use the copy table function.
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Field Name

Description

Period Status: Unlocked
Except Sales

e full Authorization: Users can add documents even when the posting period status is
Unlocked Except Sales. You must have authorization to add the relevant document.

e No Authorization: Users cannot add documents when the posting period status is
Unlocked Except Sales.

Period Status: Closing Period

e full Authorization: Users can add documents even when the posting period status is
Closing Period. You must have authorization to add the relevant document.

e No Authorization: Users cannot add documents when the posting period status is

Closing Period.

Launch Application ® full Authorization: Users can open the Launch Application window and run external ap-
plications.

e No Authorization: Users cannot open the Launch Application window. The Launch
Application icon and the |} File > Launch Application } menu are disabled.

Drag & Relate o Full Authorization: Users can access and use the Drag & Relate tab functions ([ Main
Menu > Drag & Relate } tab). You can grant authorizations for specific Drag & Relate
categories to different users. For example, a user can be authorized for Sales: A/R but
not for Financials.

e No Authorization: The Drag & Relate tab is not displayed in the Main Menu, even if you
have full authorization for the Drag & Relate subcategories.
To provide authorization for Drag & Relate functions for certain modules only, grant full au-
thorization to the Drag & Relate category, and then set No Authorization for those modules
from which the user should be excluded.
Sales: A/R e full Authorization: Users can access and use the Drag & Relate tab functions for Sales

A/R.
® No Authorization: Users cannot use the Drag & Relate functions for the Sales A/R mod-

ule.

To open documents and the Item Master Data window, you require either Read Only or Full
Authorization rights for the business partner master data.

Purchasing: A/P

® full Authorization: Users can access and use the Drag & Relate tab functions for the
Purchasing A/P module.

e No Authorization: Users cannot use the Drag & Relate functions for the Purchasing A/P
module.

To open documents and the Item Master Data window, you also require either Read Only or
Full Authorization rights for the business partner master data.

How to Define Authorizations in SAP Business One 10.0
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Field Name

Description

Business Partners

® full Authorization: Users can access and use the Drag & Relate tab functions for busi-
ness partner information.

e No Authorization: Users cannot use the Drag & Relate functions for business partner in-
formation.

You need authorization for Business Partner Master Data to open activities, and Read Only
or Full Authorization is also required to set up and use the payment terms (|} Administration

> Setup > Business Partners > Payment Terms ]).

Inventory

® full Authorization: Users can access and use the Drag &Relate tab functions for the
Inventory module.

e No Authorization: Users cannot use the Drag & Relate functions for inventory informa-
tion. To open the Item Master Data window or the Bill Of Materials window, you require
either Read Only or Full Authorization rights for item groups, warehouses, and manufac-
turers. You also require Read Only or Full Authorization for the setup of the item groups,

warehouses, and manufacturers (|’r Administration > Setup > Inventory 1).

Production

® full Authorization: Users can access and use the Drag & Relate tab functions for the
Production module. To open the production order from within the Drag & Relate tab, you
require Read Only or Full Authorization.

e No Authorization: Users cannot use the Drag & Relate functions for production informa-
tion.

Financials

® full Authorization: Users can access and use the Drag & Relate tab functions for the
Financials module. You also require authorization for the chart of accounts and the jour-
nal entry.

e No Authorization: Users cannot use the Drag & Relate functions for financials informa-
tion.

Service

® Full Authorization: Users can access and use the Drag & Relate tab functions for the
Service module. You also require Read Only or Full Authorization to open the service
contract, service call, and customer equipment card.

® No Authorization: Users cannot use the Drag & Relate functions for service information.

Renaming Fields

® Full Authorization: Users can open the Change Description window and change field
names (CTRL+ double-click a field name). You also require authorization for the rele-
vant document.

® No Authorization: Users cannot open this window.

Access Log

e full Authorization: Users can open the Access Log window (|} Tools > Access Log ]) to
view the access details of the different users.

e No Authorization: Users cannot open this window.

16 PUBLIC
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Field Name

Description

Change Log

Users can open the Change Log window (|} Tools > Change Log }) from various windows.

Full Authorization: Users can access the Change Log window. You also require authori-
zation for the relevant forms.

No Authorization: Users cannot open this window.

i Note

To view the change logs of objects, full authorizations for the objects are also re-
quired.

Users can only view the change logs of the following types of documents if they
have full authorizations for Change Log and read-only authorizations for the docu-
ments:

o Sales and purchasing documents

o Journal Entries

o Goods Issues, Goods Receipts, Receipts from Production, and Issues for Pro-
duction

o Production Orders
o Inventory Transfers and Inventory Transfer Requests
o Inventory Opening Balances, Inventory Countings, and Inventory Postings

© Incoming Payments and Outgoing Payments

Edit Form Ul

Full Authorization: Users can enter the Edit Form Ul mode and modify a form (|} Tools

» Edit Form Ul 3).

No Authorization: Users cannot enter the Edit Form Ul mode.

Organize My Menu

Full Authorization: Allows you to access the Organize My Menu window (|} Tools > My

Menu > Organize ]) and customize the menu.

No Authorization: Users cannot open this window.

Cancel Marketing Documents
by Generating Cancellation
Documents

Full Authorization: Users can generate cancellation documents

No Authorization: Users cannot generate cancellation documents

Cancel Other Documents

Full Authorization: Users can Cancel documents which don’t generate journal entries,
such as sales/purchase orders or quotations.

No Authorization: Users cannot Cancel documents which don't generate journal en-
tries, such as sales/purchase orders or quotations.

Close Document

Full Authorization: Users can close documents such as sales/purchase quotations,

sales/purchase orders, delivery and returns (|} Data > Close }), if Close is an option
for the documents.

No Authorization: Users cannot close the documents.

How to Define Authorizations in SAP Business One 10.0
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Field Name

Description

Duplicate Documents and

Full Authorization: Users can use the Duplicate option in the context menu to duplicate

Records transactional documents, such as sales orders, and duplicate data records, such as
item master data.
e No Authorization: When users choose Duplicate in the context menu, they will be asked
for authorization.
This authorization is not applicable to the Duplicate To and Duplicate Row options in the
context menu.
Change Field Labels This entry doesn't work anymore. It is now replaced by Renaming Fields.
Document Manual ® Full Authorization: Users can determine whether to manually number a document.
Numbering ® No Authorization: Users cannot determine whether to manually number a document.
Relationship Map o Full Authorization: Users can open the Relationship Map window ([ Go to #

Relationship Map }) to see a visual of an object’s relations with other objects.

No Authorization: Users cannot open this window.

Translations

Full Authorization: Users can choose the Translate ( i‘) icon in a translatable field, or
right click the field and choose Translate to open the Translations window and translate
the field value into multiple languages.

Read-Only: Users can open the Translations window but cannot add or edit any item.

No Authorization:Users cannot open the Translations window.

i Note

These authorizations are available only when you have enabled Multi-Language Support
from the |} Administration > System Initialization > Company Details > Basic

Initialization 4 tab.

Future Posting Date in

Full Authorization: Users can enter a future posting date in sales and purchasing docu-

Documents ments if Allow Future Posting Date checkbox is selected (|* Administration ¥ System
Initialization > Document Settings 1).
® No Authorization: Users cannot enter future posting dates.
Logger Settings o Full Authorization: Users can open the Logger Settings window (| Help ¥ Support

Desk }) to log file parameters.

No Authorization - Users cannot open the Logger Settings window. The window is disa-
bled.

Electronic File Manager

Full Authorization: Users can open the Electronic File Manager window

((l} Administration > Setup > General ])) to design electronic format solutions.

No Authorization: Users cannot open this window.

18 PUBLIC
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Field Name Description

SAP HANA Database Client ® full Authorization: Users can view and modify the checkbox status.
Enablement ® Read Only: Users can view the checkbox but cannot modify the checkbox status.

® No Authorization: Users cannot view or modify the checkbox status.

Disable DI APl Permission ® Full Authorization: Your authorizations are ignored in the DI APl and no requests from DI
Check API check permissions, which means all permissions are granted.

e No Authorization: Your authorizations are applied in the DI API.

How to Define Authorizations in SAP Business One 10.0
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4 Customization Tool Authorizations

The following modules and functions define the Customization Tools authorizations:

Field Name Description

Customization Tools i

Full Authorization: Users can use all the functions available under the Customization
Tools and make required changes or define new settings.

Read Only: Users can view the data defined in all the Customization Tools.

No Authorization: Users cannot access any option under the Customization Tools.

i Note

If you select the Read Only authorization for the Customization Tools menu, the authori-
zations for its child items without the Read Only option are automatically set to No
Authorization.

User-Defined Values - Setup ~ You require authorization for the relevant windows. To have authorization for queries in the

Query Manager, you must have authorizations for Query Manager and the Saved Queries -

Group No. <x> fields (|F Reports ¥ Query Generator # Saved Queries - Group No. X 3).

Full Authorization: Users can create and search for user-defined values in many fields in
SAP Business One (IF Tools » Customization Tools # User-Defined Values ).
Read Only: Users can view existing formatted searches but cannot modify them.

No Authorization: Users cannot define or view formatted searches.

User-Defined Fields - °
Management

Full Authorization: Users can view, modify and create user—defined fields (|} Tools >

Customization Tools > User—Defined Fields Management }).

No Authorization: Users cannot open this window.

Execute Commands Available for Israel only.

Full Authorization: Users can access the Execute Commands window (|} Administration
> Utilities > Execute Commands }) and execute commands written as macros.
Read Only: Users cannot open this window.

No Authorization: Users cannot open this window.

User—Defined Object b
Registration

Full Authorization: Users can access the user-defined objects registration wizard

(|} Tools > Customization Tools > Objects Registration Wizard }).Users can load DLL
files that are created by partners for user-defined objects (that are also created by part-
ners). This means that business logic, which is not part of the core application, can be
added and activated throughout the application like any other built-in functions.

No Authorization: Users cannot view or open the wizard.
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5 Administration Module Authorizations

The following modules and functions define the Administration authorizations:

Field Name Description

Administration e full Authorization: Users can enter all Administration module functions and make re-
quired changes or new settings.

® Read Only: Users can view the data defined in the Administration module.

e No Authorization: Users cannot access any of the functions in the Administration mod-
ule.

i Note

If you select the Read Only authorization for the entire Administration module, the au-
thorizations for its child items without the Read Only option are automatically set to No
Authorization.

Exchange Rates and Indexes ® full Authorization: Users can open the Exchange Rates and Indexes window
(I Administration ¥ Exchange Rates and Indexes J) and enter relevant exchange
rates.
With this authorization, the Exchange Rates and Indexes window open automatically
when users try to add a document for which any exchange rate is not defined.
® Read Only: Users can view the data in the Exchange Rates and Indexes window.

® No Authorization: Users cannot open the Exchange Rates and Indexes window.

i Note

With read only or no authorization, users cannot create a document if the exchange
rate on the creation date (if required) is not defined. This is because the users are
not authorized to update the Exchange Rates and Indexes window.

If you have already defined an exchange rate for that date, this setting has no ef-
fect.
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Field Name Description

System Initialization Controls your access to the functions in the System Initialization menu. The authorizations
selected in the System Initialization row apply to all system initialization functions. To set au-
thorizations for individual system initialization functions, select the required authorization
for each function as described below:

® Full Authorization: Users can enter all functions located in the System Initialization
menu and make changes or create new settings.

® Read Only: Users can view the data defined in all the functions located in the System
Initialization submenu.

® No Authorization: Users cannot access any function located in the System Initialization
menu.

Company Details ® Full Authorization: Users can enter the Company Details window and make required set-
tings or modifications.

® Read Only: Users can view the Company Details window.

e No Authorization: Users cannot open the Company Details window.

Allow Stock Release Without  1ps feature is available only when the Use Perpetual Inventory checkbox on the I» Company

Item Cost ) o )
Details > Basic Initialization ] tab is selected.
® Full Authorization: Users can select the Allow Stock Release Without Item Cost check-
box (|} Company Details > Basic Initialization }). Authorization for the Company
Details window is also required.
e No Authorization: Users cannot select this checkbox.
Mask Credit Card Number e full Authorization: Users can select the Mask Credit Card Number checkbox
(|} Company Details > Basic Initialization 1). Authorization for the Company Details
window is required.
e No Authorization: Users cannot select this checkbox.
i Note
As of SAP Business One 9.3 PLO4, this authorization doesn't work anymore. The check-
box is selected by default and always disabled.
General Settings ® full Authorization: Users can make changes or create new settings on all tabs of the

General Settings window. To grant authorization to define default payment terms, au-
thorization is also required for payment terms setup (|} Administration > Setup >
Business Partner > Payment Terms }) and Read Only authorization is required for the
price lists (in Inventory).

® Read Only: Users can view the data defined in the various tab pages of the General
Settings window.

e No Authorization: Users cannot open the General Settings window.
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Field Name Description

Cash Flow e Full Authorization: Users can define the global settings for assigning Cash Flow line
items to Cash Flow relevant transactions.

® Read Only: Users can view the settings of the Cash Flow tab.

® No Authorization: The Cash Flow tab is not displayed in the General Settings window.

VAT Report Settings This authorization is available for Korean localizations only.
® full Authorization: Users can view and update the settings on the VAT tab in the

|} Administration > System Initialization > Company Details } General Settings } win-
dow.
The VAT tab is visible only when the Extended Tax Reporting checkbox on the

|} Administration > System Initialization > Company Details > Accounting Data ]tab
is selected.

® Read Only: Users can view the settings of the VAT Report.

® No Authorization: The VAT tab is not displayed in the General Settings window.

Map Services e full Authorization: Users can define new Map Services (|} General Settings >

Services } tab). Authorization for the General Settings window is required.

e No Authorization: Users cannot define new Map Services.

Posting Period You open this window by choosing [* General Settings  Posting Periods 4 tab New Period
or by clicking the link arrow next to one of the posting periods in the table.
® Full Authorization: Users can enter the Posting Period window and make settings or
modifications on condition that they have Full Authorization for Change Period Status.
® Read Only: Users can view the Posting Period window on condition that they have Full
Authorization for Change Period Status.
e No Authorization: Users cannot open the Posting Period window.
Change Period Status ® Full Authorization: Users can change the period status of the posting period, including
locking it (»r Administration > System Initialization > Posting Period > Posting
Period ] window).
e No Authorization: Users are unable to change the period status.
Document Numbering ® Full Authorization: Users can enter the Document Numbering window and define a num-

bering series.
® Read Only: Users can view the Document Numbering window.

e No Authorization: Users cannot view the Document Numbering window.

i Note
The authorization for a user or user group to use a specific numbering series to gener-
ate a document is set under the category |} Administration } System Initialization >

Numbering Series > Series - Group No. <x> ]
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Field Name

Description

Document Settings

Full Authorization: Users can enter the Document Settings window and make settings or
modifications. You also require Read Only or Full Authorization rights for the Price Lists.

Read Only: Users can view the Document Settings window.

No Authorization: Users cannot open the Document Settings window.

Max. Under/Over Payment

This authorization is not applicable anymore.

Allow Future Posting

Full Authorization: Users can select or deselect the Allow Future Posting Date checkbox

(I Document Settings » General 3 tab).

No Authorization: Users cannot change this selection.

Print Preferences

Full Authorization: Users can enter the Print Preferences window and make required set-
tings or modifications.
Read Only: Users can view the Print Preferences window.

No Authorization: Users cannot open the Print Preferences window.

Menu Alias for Searching

Full Authorization: Users can define a menu alias for searching from |} Administration >

System Initialization # Menu Alias for Searching. 4

No Authorization: Users cannot open the Menu Alias for Searching window.

Menu Structure

Full Authorization: Users can define the menu structure.

No Authorization: Users cannot open the Menu Structure window.

Opening Balances

Full Authorization: Users can enter opening balances for G/L accounts, business part-
ners, and 1099 form or box.

Read Only: Users can view the Opening Balance windows only.

No Authorization: Users cannot access these options.

G/L Accounts Opening
Balance

Full Authorization: Users can open the G/L Accounts Opening Balance window and re-
cord data.

No Authorization: Users cannot access this window.

Business Partners Opening

Full Authorization: Users can open the Business Partners Opening Balance window and

Balance record relevant data.
® No Authorization: Users cannot access this window.
1099 Opening Balance Relevant only for the United States localization.

Full Authorization: Users can open the 1099 Opening Balance window and enter data.
Read Only: Users cannot access the 1099 Opening Balance window.

No Authorization: Users cannot open the 1099 Opening Balance window.
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Field Name Description

Numbering Series ® full Authorization: When users generate a document, they can view a complete list of
numbering series defined for the document and select one of them.
® Read Only: Users cannot access any document.

® No Authorization: Users cannot access any document.

i Note

If no authorization is granted to the Numbering Series option, a user cannot access any
document in SAP Business One. We recommend that you grant authorizations for ser-
ies groups as described below.

If No Authorization is granted to any numbering series groups, the user does not have
access to any documents, even if the document numbering series has been defined
correctly.

If Read Only is granted at the header level, then No Authorization is granted to all the
series groups and Read Only is applied only to locked series. In such a case, the series
groups have No Authorization or Full Authorization.

Series Lock ® Full Authorization: Users can select the Lock option for fields in the Series - <Document
Type> - Setup window.
e Read Only: Users cannot select the Lock option for fields in the Series - <Document
Type> - Setup window.
e No Authorization: Users cannot select the Lock option for fields in the Series -
<Document Type> - Setup window.

Series: Group No. 1-10 This authorization works as follows:

1. Inthe Document Numbering - Setup window, select a type of document and define a
default numbering series.

2. Double click the empty row header of the document and assign a series group number,
for example, 1, to the numbering series in the Group field of the Series - <Document
Type> - Setup window.

3. Assign one of the following authorizations for the series group Series: Group No. 1to a
certain user or user group:

o Full Authorization: When generating a document, the user or user group can view
and select the series group in the series list.

o No Authorization: The user or user group cannot access or create a document as-
signed to this group.

i Note

This setting affects the use of the Group field in the Document Numbering - Setup win-
dow.
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Field Name

Description

Copy from Unauthorized
Series Group

Full Authorization: When users use the Copy From functionality, they can view docu-
ments with a series group for which they have no authorization in the document list.

No Authorization: Users cannot view documents with a series group for which they have
no authorization.

E-Mail Settings

Full Authorization: Users can open the E-Mail Settings window and set up the E-Mail sig-
natures.

Read Only: Users can view the E-Mail Settings window.

No Authorization: Users cannot open this window.

Implementation Tasks

Select Full Authorization or No Authorization for all of the child authorizations under

Implementation Tasks.

Implementation Tasks

Full Authorization: Users can access and modify data in the Implementation Tasks win-
dow.

No Authorization: Users cannot access the Implementation Tasks window.

Implementation Project

Full Authorization: Users can open the Implementation Project menu and work with the
Edit and View tabs presented.

Read Only: Users can view the Implementation Project window.

No Authorization: Users cannot open the Implementation Project window.

Tooltip Preview

Full Authorization: Users can access and modify Tooltip Preview.

No Authorization: Users cannot access Tooltip Preview.

Setup

Select Full Authorization, Read Only, or No Authorization for all of the child authorizations

under Setup.

General

Only Superusers can modify the Password window and the password definitions in the

Users-Setup window.

Select Full Authorization, Read Only, or No Authorization for all of the child authorizations

under General.

Users

Full Authorization: Users can create, delete and modify the Users- Setup window
Read Only: Users can view the Users-Setup window

No Authorization: Users cannot access the Users-Setup window

Change My Personal Settings

Full Authorization: Users can view and change their personal settings.
Read Only: Users can view their personal settings only.

No Authorization: Users cannot view their personal settings.

User Defaults

Full Authorization: Users can create, delete and modify User Defaults in the User
Defaults window

Read Only: Users can view the User Defaults window

No Authorization: Users cannot access the User Defaults window
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Field Name

Description

Sales Employees/Buyers

Full Authorization: Users can create, delete and define Sales Employees and Buyers in

the Sales Employees/ Buyers-Setup window
Read Only: Users can view the Sales Employees/ Buyers-Setup window

No Authorization: Users cannot access the Sales Employees/ Buyers-Setup window

Territories

Full Authorization: Users can view and add territories in the Territories- Setup window

Read Only: Users can view the Territories- Setup window

No Authorization: Users cannot access the Territories- Setup window

Commission Groups

Full Authorization: Users can view and access Commission Groups
Read Only: Users can view Commission Groups

No Authorization: Users cannot access the Commission Groups

Predefined Text

Full Authorization: Users can access and modify the Predefined Text-Setup window
Read Only: Users can view the Predefined Text-Setup window

No Authorization: Users cannot access the Predefined Text-Setup window

Reference Field Links

Full Authorization: Users can access and modify Reference Field Links
Read Only: Users can view Reference Field Links

No Authorization: Users cannot access Reference Field Links

Freight

Full Authorization: Users can access and modify the Freight-Setup window
Read Only: Users can view the Freight-Setup window

No Authorization: Users cannot access the Freight-Setup window

Message Preferences

Full Authorization: Users can access and modify the Message Preferences window and

can set their preferences for some system messages with the checkbox Remember My

Answer and Do Not Show this Message Again.

No Authorization: Users cannot access the Message Preferences window or set prefer-

ences for system messages.

Report and Layout Manager

Full Authorization: Users can access and generate Report and Layout Manager

No Authorization: Users cannot access Report and Layout Manager

Dashboard Manager Full Authorization: Users can access the Dashboard Manager-Setup window
No Authorization: Users cannot access the Dashboard Manager Set-up window
Dashboard Parameters Full Authorization: Users can access Dashboard Parameters

No Authorization: Users cannot access Dashboard Parameters

Crystal Server Configuration

Full Authorization: Users can access Crystal Server Configuration

No Authorization: Users cannot access Crystal Server Configuration

SAP Links

Full Authorization: Users can view and access SAP Links
Read Only: Users can view SAP Links

No Authorization: Users cannot access SAP Links
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Field Name

Description

SAP HANA Model ® Full Authorization: Users can access and modify the window.

Management ® No Authorization: Users cannot access the window.

Financials Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Financials.

Edit Chart of Accounts ® full Authorization: Users can access and edit the chart of accounts in the Edit Chart of

Accounts window
® Read Only: Users can view the Edit Chart of Accounts window

e No Authorization: Users cannot access the Edit Chart of Accounts window

G/L Account Determination

To define G/L account determination, full authorization for Sales - Allow Changes to
Reconciliation Accounts is required, which lets you access the Allow Changes to Control
Accounts option.

G/L Account Determination

e Full Authorization: Users can access all tabs and modify the G/L Account Determination
® Read Only: Users can view the G/L Account Determination window

e No Authorization: Users cannot view or modify the G/L Account Determination

Determination Criteria -
Inventory

e full Authorization: Users can view and select criteria in the Determination Criteria-
Inventory window

® Read Only: Users can view the Determination Criteria - Inventory window

e No Authorization: Users cannot access the Determination Criteria - Inventory window

Determination Criteria -

® Full Authorization: Users can view and select criteria in the Determination Criteria-

Resources Resources window
® Read Only: Users can view the Determination Criteria - Resources window
e No Authorization: Users cannot access the Determination Criteria - Resource window
Account Segmentation ® full Authorization: Users can view and update the Account Segmentation-Setup window
® Read Only: Users can view the Account Segmentation- Setup window
e No Authorization: Users cannot access the Account Segmentation-Setup window
i Note
This window is only visible when the checkbox Use Segmentation Accounts on the
|} Company Details > Basic Initialization ]tab is selected.
Currencies ® full Authorization: Users can view and update the Currencies Setup window.

® Read Only: Users can view the Currencies Setup window

® No Authorization: Users cannot access the Currencies Setup window
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Field Name

Description

Indexes

e full Authorization: Users can add and modify Indexes in the Exchange Rates and Indexes

window
® Read Only: Users can view the Exchange Rates and Indexes window

® No Authorization: Users cannot view or modify Indexes in the Exchange Rates and
Indexes window

Transaction Codes

e Full Authorization :Users can modify and add to the Transaction Codes- Setup window

® Read Only: Users can view the Transaction Codes- Setup window

e No Authorization: Users cannot view or modify the Transaction Codes-Setup window

Projects ® Full Authorization: Users can modify and add to the Project-Setup window
® Read Only: Users can view the Projects-Setup window
® No Authorization: Users cannot view or modify the Projects-Setup window
Period Indicators ® full Authorization: Users can view and modify the Period Indicators-Setup window
® Read Only: Users can view the Period Indicators - Setup window
e No Authorization: Users cannot access the Period Indicators-Setup window
1099 Table Relevant only for the United States localization.
® full Authorization: Users can open the 1099 Table, enter data and access 1099 Boxes.
® Read Only: Users can view the 1099 Table.
e No Authorization: Users cannot access the 1099 Table
Doubtful Debts ® full Authorization: Users can add, delete and modify the data in the Doubtful Debts-
Setup window
® Read Only: Users can view the Doubtful Debts-Setup window
® No Authorization: Users cannot access the Doubtful Debts-Setup window
Tax Select Full, Read Only, or No Authorization for all of the child authorizations under Tax.

Tax Code Determination

® Full Authorization: Users can access and modify the Tax Code Determination- Setup

window
® Read Only: Users can view the Tax Code Determination-Setup window

e No Authorization: Users cannot access the Tax Code Determination-Setup window

Sales Tax Jurisdiction Types

® Full Authorization: Users can access and modify the Sales Tax Jurisdiction Types win-

dow.
® Read Only: Users can view the Sales Tax Jurisdiction Types window only.

e No Authorization: Users cannot access the Sales Tax Jurisdiction Types window.

Sales Tax Jurisdictions

® Full Authorization: Users can access and define jurisdiction from the Sales Tax
Jurisdictions-Selection Criteria window

® Read Only: Users can view the Sales Tax Jurisdictions-Selection Criteria window

e No Authorization: Users cannot access the Sales Tax Jurisdictions-Selection Criteria

window
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Field Name

Description

Sales Tax Codes

® full Authorization: Users can access and modify the Sales Tax Codes-Setup window
® Read Only: Users can view the Sales Tax Codes-Setup window

® No Authorization: Users cannot access the Sales Tax Codes-Setup window

Fixed Assets

® Full Authorization: Users can view and modify the fixed assets setup
® Read Only: Users can view the fixed assets setup

® No Authorization: Users cannot access the fixed assets setup

i Note
The authorizations for Fixed Assets and the related windows are available only when the
checkbox Enable Fixed Assets on the |[F Administration ¥ System Initialization

Company Details > Basic Initialization 4 tab is selected.

Account Determination

® full Authorization: Users can view and modify the Account Determination window
® Read Only: Users can view the Account Determination window

e No Authorization: Users cannot access the Account Determination window

Depreciation Types

® full Authorization: Users can view and modify the Depreciation Types window
® Read Only: Users can view the Depreciation Types window

o No Authorization: Users cannot access the Depreciation Types window

Depreciation Areas

® full Authorization: Users can view and modify the Depreciation Areas window
® Read Only: Users can view the Depreciation Areas window

e No Authorization: Users cannot access the Depreciation Areas window

Asset Classes

® Full Authorization: Users can view and modify the Asset Classes window
® Read Only: Users can view the Asset Classes window

e No Authorization: Users cannot access the Asset Classes window

Attribute Groups

® Full Authorization: Users can view and modify the Attribute Groups window
® Read Only: Users can view the Attribute Groups window

e No Authorization: Users cannot access the Attribute Groups window

Cash Flow Line Items

e Full Authorization: Users can add and select Cash Flow Line Iltems from the Cash Flow
Line Items-Setup window

® Read Only: Users can view the Cash Flow Line Items- Setup window

e No Authorization: Users cannot access the Cash Flow Line Items-Setup window

Financial KPI Factors (version
for SAP HANA)

® full Authorization: Users can view and modify the Financial KPI Factors window
® Read Only: Users can view the Financial KPI Factors window

e No Authorization: Users cannot access the Financial KPI Factors window

Expense Types

® full Authorization: Users can view and modify the Expense Types window
® Read Onl:: Users can view the Expense Types window

e No Authorization: Users cannot access the Expense Types window
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Field Name Description

Opportunities ® Full Authorization: Users can enter all the functions specified in the Opportunities mod-
ule and make required changes or new settings. You also require full authorization for

the sales stages, as defined in the authorizations in |} Administration > Setup >

Opportunity } You require authorization for the Close Document function (in General
Authorizations), even if authorization is not provided for setting up and viewing docu-
ments in these modules. Therefore, on the Opportunity Stages tab, when closing a row
(before opening a new row), you first may have to close a document linked to that
stage.

® Read Only: Users can view the data defined in all the functions specified in the
Opportunities module.

® No Authorization: Users cannot access any option specified in the Opportunities mod-
ule.

Opportunity Stages e Full Authorization: Users can view, add and delete Opportunities Stages in the
Opportunities Stages- Setup window

® Read Only: Users can view the Opportunities Stages- Setup window

® No Authorization: Users cannot access the Opportunities Stages- Setup window

Partners e full Authorization: Users can add, modify and delete from the Partners-Setup-Window
® Read Only: Users can view the Partner-Setup window

e No Authorization: Users cannot access the Partner Setup window

Competitors e full Authorization: Users can add, modify and delete from the Competitors-Setup win-
dow

® Read Only: Users can view the Competitors-Setup window

e No Authorization: Users cannot access the Competitors-Setup window

Relationships e Full Authorization: Users can view and add to the Relationships- Setup window

® No Authorization: Users cannot view or modify the Relationships- Setup window

Sales (version for SAP Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
HANA) under Sales.

ATP Checking Rule List (ver- ® Full Authorization: Users can view and modify the ATP Checking Rule List window
sion for SAP HANA) ® Read Only: Users can view the ATP Checking Rule List window

e No Authorization: Users cannot access the ATP Checking Rule List window

i Note

This authorization is available only when the checkbox Enable Advanced Available to
Promise in Document Settings is selected.

Purchasing Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Purchasing
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Field Name

Description

Landed Costs

Full Authorization: Users can add and modify the Landed Costs- Setup window
Read Only: Users can view the Landed Costs- Setup window

No Authorization: Users cannot access the Landed Costs- Setup window

Business Partners

Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Business Partner

Countries

Full Authorization: Users can add, modify and delete countries from the Countries-
Setup window

Read Only: Users can view the Countries-Setup window

No Authorization: Users cannot access the Countries-Setup window

Address Formats

Full Authorization: Users can insert and modify addresses in the Address Formats-Setup
window

Read Only: Users can view Address Formats only

No Authorization: Users cannot access Address Formats

Customer Groups

Full Authorization: Users can modify and add customer groups in the Customer Groups
-Setup window

Read Only: Users can view the Customer Groups Setup window

No Authorization: Users cannot access the Customer Groups Setup window

Vendor Groups

Full Authorization: Users can modify and add vendor groups in the Vendor Groups -
Setup window

Read Only: Users can view the Vendor Groups Setup window

No Authorization: Users cannot access the Vendor Groups Setup window

Business Partner Properties

Full Authorization: Users can access the Business Partner Properties-Setup window
Read Only: Users can view the Business Partner Properties-Setup window

No Authorization: Users cannot access the Business Partner Properties-Setup window

Business Partner Priorities

Full Authorization: Users can add and modify the Business Partner priority list in the
Business Partner Priorities Setup window

Read Only: Users can view Business Partner Priorities Setup window

No Authorization: Users cannot access the Business Partner Priorities Setup window

Dunning Terms

Full Authorization: Users can add and modify Dunning Terms in the Dunning Terms -
Setup window
Read Only: Users can view the Dunning Terms - Setup window

No Authorization: Users cannot access the Dunning Terms - Setup window

32 PUBLIC

How to Define Authorizations in SAP Business One 10.0
Administration Module Authorizations



Field Name Description

Payment Terms ® full Authorization: Users can modify and update the Payment Terms-Setup window
® Read Only: Users can view the Payment Terms-Setup window
® No Authorization: Users cannot access the Payment Terms-Setup window
The field value of Total Discount % in the BP Fields section of the Payment Terms-Setup
window cannot be greater than the value of the Max. Discount - General field at the bot-
tom of the General Authorizations window.
Price List displays only price lists of a price list group for which users have authoriza-

tions (|} Inventory > Price Lists })

Cash Discount ® full Authorization: Users can view and modify a cash discount in the Cash Discount win-
dow (| Payment Terms - Setup » Cash Discount Name # Define New J).
® Read Only: Users can view the Cash Discount window

e No Authorization: Users cannot view or modify cash discounts in the Cash Discount
window

Payment Blocks e full Authorization: Users can add and modify description in the Payment Blocks - Setup
window or through the |} Business Partner Master Data > Payment Run 1 tab or the
|} AP/AR Invoice > Accounting } tab. In Payment Blocks, you can describe various rea-
sons for blocking payments generated by the Payment Wizard.

® Read Only: Users can view the Payment Blocks Setup window.

e No Authorization: Users cannot access the Payment Blocks Setup window.

Target Group e Full Authorization: Users can view and update the Target Group Setup window
® Read Only: Users can view the Target Group Setup window

e No Authorization: Users cannot access the Target Group Setup window

Banking Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Banking.

Banks ® Full Authorization: Users can add, remove and modify data in the Banks-Setup window
® Read Only: Users can view the Banks-Setup window

e No Authorization: Users cannot access the Banks-Setup window

House Bank Accounts e Full Authorization: Users can add, remove and update the House Bank Accounts-Setup
window

® Read Only: Users can view the House Bank Accounts-Setup window

e No Authorization: Users cannot access the House Bank Accounts-Setup window

Credit Cards ® Full Authorization: Users can add, delete and modify the Credit Cards-Setup window
® Read Only: Users can view the Credit Cards-Setup window

o No Authorization: Users cannot access the Credit Cards-Setup window

Credit Card Payment ® full Authorization: Users can view and modify the Credit Card Payment-Setup window
® Read Only: Users can view the Credit Card Payment-Setup window

® No Authorization: Users cannot access the Credit Card Payment-Setup window
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Field Name

Description

Credit Card Payment ® full Authorization: Users can add Credit Card Payment Methods and modify the Credit
Methods Card Payment Methods-Setup window
e Read Only: Users can view the Credit Card Payment Methods-Setup window
® No Authorization: Users cannot access the Credit Card Payment Methods-Setup win-
dow
Bank Charges Allocation ® full Authorization: Users can add, modify and delete data in the Bank Charges
Codes Allocation Codes-Setup window
® Read Only: Users can view the Bank Charges Allocation Codes-Setup window
e No Authorization: Users cannot access the Bank Charges Allocation Codes-Setup win-
dow
Payment Methods ® Full Authorization: Users can add and update Payment Methods in the Payment

Methods-Setup window
® Read Only: Users can view payment methods in the Payment Methods-Setup window

e No Authorization: Users cannot access the Payment Methods-Setup window

Bank Statement Processing

® Full Authorization: Users can view and modify the data in the menu entries under the
menu entry Bank Statement Processing.

® Read Only: Users can view the data in the menu entries under the menu entry Bank
Statement Processing.

® No Authorization: Users cannot access the menu entries under the menu entry Bank
Statement Processing.

This functionality is available when the Install Bank Statement Processing checkbox in the

|} Company Details > Basic Initialization }tab is selected.

Inventory

Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Inventory.

Item Groups

® Full Authorization: Users can set up and modify Item Groups in the Item Groups-Setup

window.
® Read Only: Users can view the Item Groups Setup window

e No Authorization: Users cannot access the ltem Groups Setup window

Item Properties

® Full Authorization: Users can access the Item Properties-Setup window
® Read Only: Users can view the Item Properties-Setup window

e No Authorization: Users cannot access the Item Properties-Setup window

Warehouses

e full Authorization: Users can view and modify the Warehouse- Setup window
® Read Only: Users can view the Warehouse - Setup window

e No Authorization: Users cannot access the Warehouse -Setup window
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Field Name

Description

Enable and Disable Bin
Locations

Full Authorization: Users can select or deselect the checkbox Enable Bin Locations in
the Warehouse - Setup window. When the checkbox is selected, the warehouse can be
managed by bin locations.

No Authorization: Users cannot select or deselect the checkbox Enable Bin Locations in

the Warehouse - Setup window.

Activate and Deactivate
Warehouse

Full Authorization: Users can select or deselect the checkbox Inactive in the Warehouse

- Setup window.
No Authorization: Users cannot select or deselect the checkbox Inactive in the
Warehouse - Setup window.

To enable this authorization, Full Authorization for Warehouses is required.

Units of Measure

Full Authorization: Users can add and modify data in the Units of Measure -Setup win-
dow

Read Only: Users can view the Units of Measure -Setup window

No Authorization: Users cannot access the Units of Measure -Setup window

Unit of Measure Groups

Full Authorization: Users can modify and define new Unit of Measure Groups in the Unit

of Measure Groups- Setup window

Read Only: Users can view Unit of Measure Groups in the Unit of Measure Groups- Setup

window

No Authorization: Users cannot access the Unit of Measure Groups- Setup window

Length and Width

Full Authorization: Users can add and modify Length and Width definitions in the Length

and Width-Setup window
Read Only: Users can view Length and Width definitions in the Length and width-Setup

window

No Authorization: Users cannot access the Length and width-Setup window

Weight

Full Authorization: Users can add and modify Weight definitions in the Weight-Setup

window
Read Only: Users can view Weight definitions in the Weight-Setup window

No Authorization: Users cannot access the Weight-Setup window

Payment Terms

Full Authorization: Users can modify and update the Payment Terms-Setup window
Read Only: Users can view the Payment Terms-Setup window

No Authorization: Users cannot access the Payment Terms-Setup window

i Note

The field value of Total Discount % in the BP Fields section of the Payment Terms-Setup
window cannot be greater than the value of the Max. Discount - General field at the bot-
tom of the General Authorizations window.

Price List displays only price lists of a price list group for which users have authoriza-

tions (|} Inventory > Price Lists ])
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Field Name

Description

Cash Discount

Full Authorization: Users can view and modify a cash discount in the Cash Discount win-
dow (|} Payment Terms - Setup > Cash Discount Name > Define New ]).
Read Only: Users can view the Cash Discount window

No Authorization: Users cannot view or modify cash discounts in the Cash Discount
window

Payment Blocks

Full Authorization: Users can add and modify description in the Payment Blocks - Setup
window or through the |} Business Partner Master Data > Payment Run 1 tab or the
|} AP/AR Invoice > Accounting ] tab. In Payment Blocks, you can describe various rea-

sons for blocking payments generated by the Payment Wizard.
Read Only: Users can view the Payment Blocks Setup window.

No Authorization: Users cannot access the Payment Blocks Setup window.

Target Group Full Authorization: Users can view and update the Target Group Setup window
Read Only: Users can view the Target Group Setup window
No Authorization: Users cannot access the Target Group Setup window
Banking Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Banking.
Banks Full Authorization: Users can add, remove and modify data in the Banks-Setup window

Read Only: Users can view the Banks-Setup window

No Authorization: Users cannot access the Banks-Setup window

House Bank Accounts

Full Authorization: Users can add, remove and update the House Bank Accounts-Setup
window

Read Only: Users can view the House Bank Accounts-Setup window

No Authorization: Users cannot access the House Bank Accounts-Setup window

Credit Cards Full Authorization: Users can add, delete and modify the Credit Cards-Setup window
Read Only: Users can view the Credit Cards-Setup window
No Authorization: Users cannot access the Credit Cards-Setup window
Credit Card Payment Full Authorization: Users can view and modify the Credit Card Payment-Setup window
Read Only: Users can view the Credit Card Payment-Setup window
No Authorization: Users cannot access the Credit Card Payment-Setup window
Credit Card Payment Full Authorization: Users can add Credit Card Payment Methods and modify the Credit
Methods Card Payment Methods-Setup window

Read Only: Users can view the Credit Card Payment Methods-Setup window

No Authorization: Users cannot access the Credit Card Payment Methods-Setup win-
dow
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Field Name Description
Bank Charges Allocation ®  Full Authorization: Users can add, modify and delete data in the Bank Charges
Codes Allocation Codes-Setup window
® Read Only: Users can view the Bank Charges Allocation Codes-Setup window
® No Authorization: Users cannot access the Bank Charges Allocation Codes-Setup win-
dow
Payment Methods ® Full Authorization: Users can add and update Payment Methods in the Payment

Methods-Setup window
® Read Only: Users can view payment methods in the Payment Methods-Setup window

e No Authorization: Users cannot access the Payment Methods-Setup window

Bank Statement Processing

e full Authorization: Users can view and modify the data in the menu entries under the
menu entry Bank Statement Processing.

® Read Only: Users can view the data in the menu entries under the menu entry Bank
Statement Processing.

® No Authorization: Users cannot access the menu entries under the menu entry Bank
Statement Processing.

This functionality is available when the Install Bank Statement Processing checkbox in the

|) Company Details > Basic Initialization 1tab is selected.

Inventory

Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Inventory.

Item Groups

e full Authorization: Users can set up and modify ltem Groups in the Item Groups-Setup
window.

® Read Only: Users can view the Item Groups Setup window

e No Authorization: Users cannot access the [tem Groups Setup window

Item Properties

® full Authorization: Users can access the Item Properties-Setup window
® Read Only: Users can view the Item Properties-Setup window

e No Authorization: Users cannot access the Item Properties-Setup window

Warehouses ® full Authorization: Users can view and modify the Warehouse- Setup window

® Read Only: Users can view the Warehouse - Setup window

® No Authorization: Users cannot access the Warehouse -Setup window
Enable and Disable Bin e full Authorization: Users can select or deselect the checkbox Enable Bin Locations in
Locations the Warehouse - Setup window. When the checkbox is selected, the warehouse can be

managed by bin locations.
o No Authorization: Users cannot select or deselect the checkbox Enable Bin Locations in
the Warehouse - Setup window.
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Field Name

Description

Activate and Deactivate
Warehouse

Full Authorization: Users can select or deselect the checkbox Inactive in the Warehouse
- Setup window.

No Authorization: Users cannot select or deselect the checkbox Inactive in the
Warehouse - Setup window.

To enable this authorization, Full Authorization for Warehouses is required.

Units of Measure

Full Authorization: Users can add and modify data in the Units of Measure -Setup win-
dow

Read Only: Users can view the Units of Measure -Setup window

No Authorization: Users cannot access the Units of Measure -Setup window

Unit of Measure Groups

Full Authorization: Users can modify and define new Unit of Measure Groups in the Unit
of Measure Groups- Setup window

Read Only: Users can view Unit of Measure Groups in the Unit of Measure Groups- Setup
window

No Authorization: Users cannot access the Unit of Measure Groups- Setup window

Length and Width

Full Authorization: Users can add and modify Length and Width definitions in the Length
and Width-Setup window

Read Only: Users can view Length and Width definitions in the Length and width-Setup
window

No Authorization: Users cannot access the Length and width-Setup window

Weight

Full Authorization: Users can add and modify Weight definitions in the Weight-Setup

window
Read Only: Users can view Weight definitions in the Weight-Setup window

No Authorization: Users cannot access the Weight-Setup window

Customs Groups

Full Authorization: Users can add, delete and modify the Customs Groups-Setup win-
dow

Read Only: Users can view the Customs Groups in the Customs Groups Setup window

No Authorization: Users cannot access the Customs Groups Setup window

Manufacturers Full Authorization: Users can modify, delete and add Manufacturers to the
Manufacturers-Setup window
Read Only: Users can view Manufacturers in the Manufacturers-Setup window
No Authorization: Users cannot access the Manufacturers-Setup window

Shipping Types Full Authorization: Users can add, delete and modify Shipping Types in the Shipping

Types-Setup window
Read Only: Users can view Shipping Types in the Shipping Types-Setup window

No Authorization: Users cannot access the Shipping Types-Setup window
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Field Name Description

Locations ® full Authorization: Users can view, add and remove locations from the Locations- Setup
window

® Read Only: Users can view locations in the Locations-Setup window

® No Authorization: Users cannot access the Locations -Setup window

Inventory Cycles ® full Authorization: Users can modify and set up Inventory Cycles from the Inventory
Cycles-Setup window

® Read Only: Users can view Inventory Cycles in the Inventory Cycles-Setup window

e No Authorization: Users cannot access the Inventory Cycles- Setup window

Cycle Count Determination ® Full Authorization: Users can access Cycle Count Determination in the Cycle Count
Determination-Setup window

® Read Only: Users can view the Cycle Count Determination-Setup window

e No Authorization: Users cannot access the Cycle Count Determination-Setup window

Package Types ® Full Authorization: Users can add, modify and remove package types in the Package
Types-Setup window

® Read Only: Users can view the Package Types-Setup window

e No Authorization: Users cannot access the Package Types-Setup window

Bin Locations Select Full, Read Only, or No Authorization for all of the child authorizations under Bin
Locations.

Bin location entries are displayed only when the checkbox Enable Bin Locations for a ware-
house is selected in the Warehouse- Setup window.

Bin Location Field Activation ® Full Authorization: Users can view and modify the Bin Location Field Activation window
® Read Only: Users can view the Bin Location Field Activation window

e No Authorization: Users cannot access the Bin Location Field Activation window

Bin Location Attribute Codes ~ ® Full Authorization: Users can add and modify the Bin Location Attribute Codes to the
Bin Location Attribute Codes window

® Read Only: Users can view the Bin Location Attribute Codes window

® No Authorization: Users cannot view or modify the Bin Location Attribute Codes window

Warehouse Sublevel Codes e Full Authorization: Users can access and define Warehouse Sublevel Codes on the
Warehouse Sublevel Codes-Setup window

® Read Only: Users can view the Warehouse Sublevel Codes-Setup window

e No Authorization: Users cannot access the Warehouse Sublevel Codes Setup window

Warehouse Sublevel Code ® Full Authorization: Users can access and generate Warehouse Sublevel Code manage-
Management ment in the Warehouse Sublevel Code Management-Setup window

® Read Only: Users can view the Warehouse Sublevel Code Management-Setup window

® No Authorization: Users cannot access the Warehouse Sublevel Code Management-
Setup window
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Field Name

Description

Resources

Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Resources

Resource Groups

® Full Authorization: Users can view and modify the Resource Groups window
® Read Only: Users can view the Resource Groups window

® No Authorization: Users cannot access the Resource Groups window

Resource Properties

e Full Authorization: Users can view and modify the Resource Properties window
® Read Only: Users can view the Resource Properties window

® No Authorization: Users cannot access the Resource Properties window

Service

Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Service

Contract Templates

e full Authorization: Users can add and modify Contract Templates in the Contract
Templates-Setup window

® Read Only: Users can view Contract Templates in the Contract Templates-Setup window

® No Authorization: Users cannot access the Contract Templates-Setup window

Queues ® Full Authorization: Users can modify, add or remove Queues on the Queues-Setup win-
dow.
® Read Only: Users can view the Queues-Setup window
e No Authorization: Users cannot access the Queues-Setup window
Project Management Select Full Authorization, Read Only, or No Authorization for all of the child authorizations

under Project Management

The Project Management options are displayed only when the Enable Project Management

checkbox in the |} Company Details > Basic Initialization 1 tab is selected.

Stages - Setup

e full Authorization: Users can view and modify the Stages - Setup window.
® Read Only: Users can view the Stages - Setup window.

e No Authorization: Users cannot access the Stages - Setup window.

Activity Type - Setup

e full Authorization: Users can view and modify the Activity Type - Setup window.
® Read Only: Users can view the Activity Type - Setup window.

e No Authorization: Users cannot access the Activity Type - Setup window.

Production Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Production
Route Stages ® full Authorization: Users can view and modify the Route Stages window.

® Read Only: Users can view the Route Stages window.

e No Authorization: Users cannot access the Route Stages window.

Data Import/Export

Select Full Authorization or No Authorization for all of the child authorizations under Data
Import/Export
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Field Name Description

Data Import Select Full Authorization or No Authorization for all of the child authorizations under Data
Import
Import from Excel ® full Authorization: Users can access the Import from Excel window and import data

from Microsoft Excel files

o No Authorization: Users cannot access the Import from Excel window

Import Transactions from ® Full Authorization: Users can access the Import Transactions from SAP Business One
SAP Business One window and choose the data to be imported.

e No Authorization: Users cannot access the Import Transactions from SAP Business One

window
Import Fixed Assets Master ® Full Authorization: Users can access the Import Fixed Assets Master Data from Microsoft
Data from Microsoft Excel Excel window and choose the data to be imported.

e No Authorization: Users cannot access the Import Fixed Assets Master Data from
Microsoft Excel window

Financial Template Import ® full Authorization: Users can access the Financial Template Import Wizard windowand
Wizard choose the data to be imported.

e No Authorization: Users cannot access the Financial Template Import Wizard window

Data Export e Full Authorization: Users can perform the data export actions available (| Data

Import/Export > Data Export }).

e No Authorization: Users cannot use this function.

Utilities Select Full Authorization, Read Only, or No Authorization for all of the child authorizations
under Utilities

Period-End Closing ® full Authorization: Users can open the Period-End Closing window and perform period-
end closing transactions.

® No Authorization: Users cannot open this window.

Update Control Report The Update Control Report opens automatically after the completion of an upgrade process.

® full Authorization: Users can view the Update Control report and perform year transfer
operations.

® Read Only: Users can view the Update Control report but cannot select the Display
Non-matching Quantities Only checkbox.

No Authorization: Users cannot view the Update Control report.

Check Document Numbering ~®  Full Authorization: Users can open the Check Document Numbering window and per-
- Selection Criteria form this operation.

No Authorization: Users cannot open this window.
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Field Name

Description

Data Archive Wizard

Full Authorization: Users can access and run the Data Archive Wizard.

No Authorization: Users cannot access this window.

i Note

Full authorization for Data Archive Wizard Execution is required to execute the wizard
(the final step in the Wizard).

Data Archive Wizard
Execution

Full Authorization: Users can access, run and execute the Data Archive Wizard.

No Authorization: Users cannot execute the Data Archive Wizard.

i Note

With full authorization for Data Archive Wizard but no authorization for Data Archive
Wizard Execution, users can access all Wizard Options in Step 2 but cannot execute the
wizard.

Master Data Cleanup Wizard

Full Authorization: Users can open the Check Master Data Cleanup Wizard window and
perform this operation.

No Authorization: Users cannot open this window.

Change Logs Cleanup e Full Authorization: Users can open the Change Log Cleanup window.
To execute the cleanup, Full Authorization for Execute Change Log Cleanup is required.
e No Authorization: Users cannot open this window.
Execute Change Logs e full Authorization: Users can execute the change log cleanup.
Cleanup This authorization is available only when Full Authorization is set to Change Log

Cleanup.

No Authorization: Users cannot execute the change log cleanup.

Manual Master Data Series
Converter

Full Authorization: Users can open the Check Manual Master Data Series Converter win-
dow and perform this operation.

No Authorization: Users cannot open this window.

Revalidate Manual Internal
Reconciliations

Full Authorization: Users can open the Revalidate Manual Internal Reconciliations win-
dow and perform this operation.

No Authorization: Users cannot open this window.

Transfer Posting Correction
Wizard

Full Authorization: Users can access the Transfer Posting Correction Wizard window and
post corrections resulted from VAT changes.

No Authorization: Users cannot open this window.
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Field Name

Description

Restore

Full Authorization: Users can perform the restore options underl} Help > Support

Desk } Restore }
No Authorization: Users cannot perform any restore operations.

i Note

All restore actions may be performed only in accordance with direct instruction from
your SAP Business One Support Center.

Restore G/L Account and
Business Partner Balances

Full Authorization: Users can choose the option Restore G/L Account and Business
Partner Balances

No Authorization: Users cannot choose the option Restore G/L Account and Business
Partner Balances

Restore Item Balances

Full Authorization: Users can choose the Restore Item Balances option

No Authorization: Users cannot choose the Restore [tem Balances option

Restore Numbering File

Full Authorization: Users can choose the Restore Numbering File option

No Authorization: Users cannot choose the Restore Numbering File option

Restore System Reports

Full Authorization: Users can choose the Restore System Reports option

No Authorization: Users cannot choose the Restore System Reports option

Restore Stored Procedures

Full Authorization: Users can choose the Restore Stored Procedures option

No Authorization: Users cannot choose the Restore Stored Procedures option

Ul Configuration Template

Full Authorization: Users can open the Ul Configuration Template window and add/
modify Ul templates.

No Authorization: Users can open the Ul Configuration Template window

i Note

To add a template for a form, make sure that you have authorization for the specific
form.

To add a template to a document, make sure that you have authorizations for the docu-
ment and for Numbering Series.

Data Protection Tools

Select Full Authorization or No Authorization for all of the child authorizations under Data

Protection Tools

The functionality is available only when the Enable Personal Data Protection Management

checkbox in the |} Company Details > Basic Initialization 1 tab is selected.

Personal Data Management

Full Authorization: Users can view and modify the Personal Data Management window
Read Only: Users can view the Personal Data Management window

No Authorization: Users cannot access the Personal Data Management window
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Field Name

Description

Personal Data Management
Wizard

Select Full Authorization or No Authorization for the actions that users can perform in the
Personal Data Management Wizard.

Personal Data Report

Full Authorization: Users can see and perform the Personal Data Report action to create
areport

No Authorization: Users cannot see or perform the Personal Data Report action

Personal Data Cleanup

Full Authorization: Users can see and perform the Personal Data Cleanup action

No Authorization: Users cannot see or perform the Personal Data Cleanup action

Personal Data Blocking

Full Authorization: Users can see and perform the Personal Data Blocking action

No Authorization: Users cannot see or perform the Personal Data Blocking action

Personal Data Unblocking

Full Authorization: Users can see and perform the Personal Data Unblocking action

No Authorization: Users cannot see or perform the Personal Data Unblocking action

Determine Natural Persons

Full Authorization: Users can see and perform the Determine Natural Persons action or
the Reverse Natural Person Determination action

No Authorization: Users cannot see or perform the Determine Natural Persons action or
the Reverse Natural Person Determination action

View Sensitive Personal Data

Full Authorization: Users can view the sensitive data by choosing Display Sensitive Data
in the context menu

No Authorization: Users cannot view the sensitive data

View Sensitive Personal Data
Access Log

Full Authorization: Users can access the Sensitive Personal Data Access Log window

No Authorization: Users cannot access the Sensitive Personal Data Access Log window

Approval Process

Select Full or No Authorization for all of the child authorizations under Approval Process

Approval Stages

Full Authorization: Users can access the Approval Stages window, define new approval
stages and modify existing ones.

Read Only: Users can view the Approval Stages window.

No Authorization: Users cannot open the Approval Stages window.
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Description

Approval Templates

Full Authorization: Users can access the Approval Templates window, define new appro-
val templates, and modify existing ones.

To define terms based on user queries, Full Authorization for Query Manager is required.
In the list of user queries, you can view only quires of a query group for which you have
authorization.

Read Only: Users can view the Approval Templates window.

No Authorization: Users cannot open the Approval Templates window.

i Note
The Originator needs to have Full Authorization for the selected documents.

The authorizer needs to have read only or full authorization for the selected documents
in order to be able to view the drafts pending for approval before approving or rejecting
them. With no authorization for the selected documents, the authorizer can approve or
reject a request, but cannot access the draft.

Approval Status Report

Full Authorization: Users can run the Approval Status report, view the report results, and

change the approval status to Canceled through the context menu.

To view the details of a document in the report, Read Only or Full Authorization rights
for the document is required.

No Authorization: Users cannot open this report.

Approval Decision Report

Full Authorization: Users can run the Approval Decision report and update approval de-

cisions for your related requests for approval. To view the documents listed in the re-
port, you require Read Only or Full Authorization rights for the relevant documents.

No Authorization: Users cannot open this report.

Substitute Authorizer for
Approval Templates

Full Authorization: Users can open and modify data in the Substitute Authorizer for
Approval Templates window.
Read Only: Users can view the Substitute Authorizer for Approval Templates window.

No Authorization: Users cannot open the Substitute Authorizer for Approval Templates
window.

Alerts Management

Full Authorization: Users can open the Alerts Management window, define new alerts,
and update system alerts.
To generating new alerts, Full Authorization for the Query Manager is required.

In the list of user queries, you can view only quires of a query group for which you have

authorization.
Read Only: Users can view the Alerts Management window.

No Authorization: Users cannot open the Alerts Management window.
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Field Name

Description

Remove User Alerts

Full Authorization: Users can remove user alerts.

No Authorization: Users cannot remove user alerts unless they are authorized.

If you're upgrading from a lower version to SAP Business One 10.0 FP 2008, users with
full authorization for alerts management are given full authorization to remove user
alerts by default, while users with no authorization for alerts management are given no
authorization to remove user alerts by default.

Bl OnDemand Integration
Configuration

Full Authorization: Users can open the Bl OnDemand Integration Configuration window
to upload query results to Bl OnDemand.

Read Only: Users can view the Bl OnDemand Integration Configuration window.

No Authorization: Users cannot open this window

Workflow Select Full Authorization or No Authorization for all of the child authorizations under
Workflow
Workflow Instance Full Authorization: Users can open and modify data in the Workflow Instance window

No Authorization: Users cannot open this window

Workflow Worklist

Full Authorization: Users can open and modify data in the Workflow Worklist window

No Authorization: Users cannot open this window

Workflow Manager Full Authorization: Users can open and modify data in the Workflow Manager window
No Authorization: Users cannot open this window
Workflow Tracking Full Authorization: Users can open and modify data in the Workflow Tracking window

No Authorization: Users cannot open this window

Alerts Management

Full Authorization: Users can open the Alerts Management window, define new alerts,
and update system alerts. To select queries for the alerts requires authorization for the
Query Manager.

Read Only: Users can view the Alerts Management window.

No Authorization: Users cannot open the Alerts Management window.

Bl OnDemand Integration
Configuration

Full Authorization: Users can open the Bl OnDemand Integration Configuration window
to upload query results to Bl OnDemand.
Read Only: Users can view the Bl OnDemand Integration Configuration window.

No Authorization: Users cannot open this window.
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6 Financials Module Authorizations

The following modules and functions define the Financials authorizations:

Field Name Description

Financials Controls your access to all functions in the Financials module. The authorizations selected
in the Financials row apply to all Financials functions. To set authorizations for individual
functions, select the required authorization for each function as described in this table.

e full Authorization: Users can enter all the functions specified in the Financials module
and make required changes or new settings.

® Read Only: Users can view the data defined in all the functions specified in the
Financials module.

e No Authorization: Users cannot access any option specified in the Financials module.

i Note

If you select Read Only authorization for the entire Financials module, the authoriza-
tions for its child items without the Read Only option are automatically set to No
Authorization.

Chart of Accounts ® Full Authorization: Users can open the Chart of Accounts window, create new G/L ac-
counts, and modify existing ones.
This includes access to the Chart of Accounts window from other parts of SAP Business
One. For example, users can access the Chart of Accounts window through the arrow
link to the G/L account from a marketing document.
® Read Only: Users can view the Chart of Accounts window.

® No Authorization: Users cannot open the Chart of Accounts window.

i Note

Users with no authorization for Chart of Accounts can still view the accounts data and
the related balances in the financial reports for which they have authorizations.

User with no authorization for Chart of Accounts but with authorization for Form
Settings can design the List of Accounts window and choose the data to be displayed
from chart of accounts.

Account Code Generator This feature is available only when the Use Segmentation Accounts checkbox is selected in
the |} Company Details > Basic Initialization }tab.
® full Authorization: Users can open the Account Code Generator window and generate

G/L account codes when working with segmentation accounts.

e No Authorization: Users cannot open the Account Code Generator window.
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Field Name Description

Journal Entry Prerequisites for this authorization are as follows:

1. Find Journal Entries in the Document Numbering - Setup window and define a default
numbering series.

2. Double click the empty row header of the document type and assign a series group
number, for example, 1, to the numbering series in the Group field of the Series - Journal
Entries - Setup window.

3. Assign full authorization for the series group to the users in the General Authorizations

window |} (Administration > System Instillation > Numbering Series > Series - Group
No.1) 3.

e Full Authorization: Users can open the Journal Entry window, add manual journal en-
tries, and perform all actions related to journal entries.
Note that users can access only journal entries with numbering series which are as-
signed to series groups for which they have full authorizations.

® Read Only: Users can view the Journal Entry window.

e No Authorization: Users cannot open the Journal Entry window.

i Note

e Users with no authorization for Access to Confidential Accounts but with full au-
thorization or read only authorization for journal entries can view journal entries
posted to the confidential accounts for which the users have authorization for the
associated numbering series.

e \When a user is authorized to access financial reports, the user can view journal en-
tries with all numbering series no matter if the user has authorization for the series
or not. However, the user can only access the journal entries with numbering series
for which the user has read only or full authorization.

e Modifying the Journal Entry window, for example, displaying or hiding certain fields
in the Form Settings window, requires full authorization for Form Settings.
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Field Name

Description

Update Posting Data

Full Authorization: Users can update all the active fields in an existing journal entry,
such as Ref. 1, Indicator, and Project.

Read Only: Users cannot update any fields in an existing journal entry with the excep-
tion of Due Date and Details.

No Authorization: Users cannot update any fields in an existing journal entry with the
exception of Due Date and Details.

i Note

A user with no authorization for the Journal Entry or Update Posting Data windows can-
not update the Document Date and the Posting Date fields in the journal entry rows,
even if the user is granted full authorization for these options.

In a sales or purchasing document that generates a journal entry, some fields can be
updated, such as the Customer or Vendor Reference No fields. However, this informa-
tion is not updated automatically in the Journal Entry window, in fields such as Ref. 2. If
you do not have full authorization to update posting data, Users cannot manually up-
date this data in the corresponding journal entry. In this case, the journal entry informa-
tion does not match the sales or purchasing document.

Confirm Entry with Multiple
Currencies

Full Authorization: Users can select or deselect the Block Multi Currency Journal Entry
checkbox (|} Administration > System Initialization > Document Settings > Per

Document 1 tab Journal Entry). You also require authorization for the Document
Settingswindow.

No Authorization: Users cannot change the selection of the Block Multi Currency
Journal Entry checkbox.

Confirm Unbalanced FC Entry

Full Authorization: Users can select or deselect the Block Unbalanced FC Journal Entry

checkbox (|} Administration > System Initialization > Document Settings > Per
Document 1 tab Journal Entry). You also require authorization for the Document
Settings window.

No Authorization: Users cannot change the selection of the Block Unbalanced FC
Journal Entry checkbox.

Confirm Row Posting Date
Editing

Full Authorization: Users can select or deselect the Block Posting Date Editing per Row
checkbox (|} Administration > System Initialization > Document Settings > Per
Document 1 tab Journal Entry). You also require authorization for the Document
Settings window.

No Authorization: Users cannot change the selection of the Block Posting Date Editing
per Row checkbox.
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Field Name Description

Allow Row Doc. Date Editing ® Full Authorization: Users can select or deselect the Block Document Date Editing per
Row checkbox (|} Administration > System Initialization > Document Settings > Per

Document } tab Journal Entry). You also require authorization for the Document
Settings window.

e No Authorization: Users cannot change the selection of the Block Document Date
Editing per Row checkbox.

Confirm SC Editing ® full Authorization: Users can select or deselect the Block Editing of Totals in System
Currency checkbox (|} Administration > System Initialization > Document Settings >

Per Document } tab Journal Entry). You also require authorization for the Document
Settings window.

® No Authorization: Users cannot change the selection of the Block Editing of Totals in
System Currency checkbox.

Journal Vouchers e full Authorization: Users can open the Journal Vouchers window, add journal vouchers,
modify existing vouchers, and delete vouchers.
To post journal vouchers to the accounting system, full authorization for Journal Entry
is required. For more information, see the description on the Journal Entry authoriza-
tion.
® Read Only: Users can view the Journal Vouchers window.

o No Authorization: Users cannot open the Journal Vouchers window.

Posting Templates ® Full Authorization: Users can open the Posting Templates window, add new templates,
and update existing ones.

® Read Only: Users can view the Posting Templates window.

® No Authorization: Users cannot open the Posting Templates window.

Recurring Postings e Full Authorization: Users can open the Recurring Postings window, add new recurring
postings, and update the existing ones.

® Read Only: Users can view the Recurring Postings window.

e No Authorization: Users cannot open the Recurring Postings window.

i Note

When you log on to the application, if the circumstances listed below are in effect, SAP
Business One displays the error message:

You are not permitted to perform this action: Recurring
Postings.
e The Display Recurring Postings on Execution checkbox is selected (Administration
|} System Initialization > General Settings > Services ]tab).

® You have no authorization for the Recurring Postings window.

e There are recurring postings scheduled for execution.
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Field Name

Description

Reverse Transactions

Full Authorization: Users can open the Reverse Transactions window and cancel trans-
actions scheduled to be reversed today.

Read Only: Users can view the Reverse Transactions window but cannot reverse trans-
actions.

No Authorization: Users cannot open the Reverse Transactions window.

i Note

When you log on, if the circumstances listed below are in effect, SAP Business One dis-
plays the error message:

You are not permitted to perform this action: Reverse

Transactions.

® You have no authorization for the Reverse Transactions window.

® There are Reverse Transactions scheduled to be cancelled today

Exchange Rate Differences

Full Authorization: Users can open the Exchange Rate Differences window, perform ex-
change rate differences transactions, and save approved transactions.

If the exchange rate for the day on which this report is run is not defined in the
Exchange Rates and Indexes window and users have no authorization for Exchange
Rates and Indexes, this authorization will not take effect.

No Authorization: Users cannot open this window.

Conversion Differences

Full Authorization: Users can open the Conversion Rate Differences window and perform

conversion differences transactions.

If the exchange rate for the day on which this report is run is not defined in the
Exchange Rates and Indexes window and users have no authorization for Exchange
Rates and Indexes, this authorization will not take effect.

No Authorization: Users cannot open this window.

1099 Editing

Relevant only to the United States localization.

Full Authorization: Users can open the 1099 Editing window and update 1099 Forms,
Boxes and Amounts.

Read Only: Users can view the 1099 Editing window.

No Authorization: Users cannot open the 1099 Editing window.

Financial Report Templates

Full Authorization: Users can open the Financial Report Templates window, design new
financial report templates, and update existing ones.

No Authorization: Users cannot open this window.

Process Checklist

Full Authorization: Users can open the Process Checklistwindow and define the visual
presentation of business processes.

Read Only: Users can view the data in this window.

No Authorization: Users cannot open this window.
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Field Name

Description

Journal Voucher Report

® full Authorization: Users can create a report that provides comprehensive information
on existing journal vouchers.

e No Authorization: Users cannot create a Journal Voucher report.

Fixed Assets e full Authorization: Users can access all windows in the Fixed Assets menu and add or
edit the data.
® Read Only: Users can view all windows in the Fixed Assets menu.
® No Authorization: Users cannot access any window in the Fixed Assets menu.
The Fixed Assets authorizations and the related windows are available only when the check-
box Enable Fixed Assets on the Basic Initialization tab of the |} Administration > System
Initialization > Company Details }window is selected.
Asset Master Data ® full Authorization: Users can access this window and add or modify the data.

® Read Only: Users can view the data in this window.

® No Authorization: Users cannot open this window.

Capitalization

® Full Authorization: Users can access this window and generate documents.
® Read Only: Users can view the data in this window.

e No Authorization: Users cannot access this window.

This authorization is available only when the default Fixed Asset Capitalization series is de-
fined for the users in the Document Numbering window and the users have authorization for

the series group number under | Administration System Instillation > Numbering

Series } in the General Authorizations window.

Capitalization Credit Memo

e full Authorization: Users can access this window and generate documents.
e Read Only: Users can view the data in this window.

e No Authorization: Users cannot access this window.

This authorization is available only when the default Fixed Asset Capitalization series is de-
fined for the users in the Document Numbering window and the users have authorization for

the series group number under |} Administration } System Instillation > Numbering

Series 4 in the General Authorizations window.

Retirement

e full Authorization: Users can access this window and generate documents.
® Read Only: Users can view the data in this window.

e No Authorization: Users cannot access this window.

This authorization is available only when the default Fixed Asset Capitalization series is de-
fined for the users in the Document Numbering window and the users have authorization for

the series group number under |} Administration > System Instillation > Numbering

Series } in the General Authorizations window.
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Field Name

Description

Transfer

® full Authorization: Users can access this window and generate documents.
® Read Only: Users can view the data in this window.

e No Authorization: Users cannot access this window.

This authorization is available only when the default Fixed Asset Capitalization series is de-
fined for the users in the Document Numbering window and the users have authorization for

the series group number under |} Administration > System Instillation > Numbering

Series } in the General Authorizations window.

Manual Depreciation

® Full Authorization: Users can access this window and generate documents.
® Read Only: Users can view the data in this window.

e No Authorization: Users cannot access this window.

This authorization is available only when the default Fixed Asset Capitalization series is de-
fined for the users in the Document Numbering window and the users have authorization for

the series group number under |} Administration } System Instillation > Numbering

Series } in the General Authorizations window.

Depreciation Run

® Full Authorization: Users can access this window, view previously created depreciation
runs and execute depreciation runs.

® Read Only: Users can access this window and view previously created depreciation
runs.

® No Authorization: Users cannot access this window.

Asset Revaluation

® full Authorization: Users can access this window and generate documents.
® Read Only: Users can view the data in this window.

e No Authorization: Users cannot access this window.

This authorization is available only when the default Fixed Asset Capitalization series is de-
fined for the users in the Document Numbering window and the users have authorization for

the series group number under |} Administration > System Instillation > Numbering

Series } in the General Authorizations window.

Fiscal Year Change

e full Authorization: Users can access this window and start a fiscal year change to calcu-
late the year-end value of assets.
® Read Only: Users can view the data in this window.

e No Authorization: Users cannot access this window.

Fixed Asset Reports

e Full Authorization: Users can access all windows in the Fixed Asset Reports menu and
run the reports.

® No Authorization: Users cannot access any window in the Fixed Asset Reports menu.

Asset Depreciation Forecast
Report

® Full Authorization: Users can access this window and run the report.

® No Authorization: Users cannot access this window.

Asset History Sheet

® Full Authorization: Users can access this window and run the report.

e No Authorization: Users cannot access this window.

How to Define Authorizations in SAP Business One 10.0

Financials Module Authorizations

PUBLIC 53



Field Name

Description

Asset Status Report

Full Authorization: Users can access this window and run the report.

No Authorization: Users cannot access this window.

Asset Transaction Report

Full Authorization: Users can access this window and run the report.

No Authorization: Users cannot access this window.

Internal Reconciliations

Full Authorization: Users can access all windows in the Internal Reconciliations menu
and manage reconciliations.

Read Only: Users can access all windows in the Internal Reconciliations menu.

No Authorization: Users cannot access any window in the Internal Reconciliations menu

Reconciliation

Full Authorization: Users can internally reconcile transactions created for G/L accounts.

Read Only: Users can view transactions available for reconciliation but cannot reconcile
them.

No Authorization: Users cannot open the Reconciliation window.

Budget Setup

Full Authorization: Users can access all windows and reports in the Budget menu and
configure budget setups.
Read Only: Users do not have full access to the Budget windows but have either Read
Only or No Authorization.

No Authorization: Users cannot access any window in the Budget menu.

Budget Scenarios - Setup

Full Authorization: Users can open the Budget Scenarios - Setup window, define new
scenarios, update existing ones, and import budget scenarios.

To enable the Import Scenario optionin the Budget Scenarios - Setup window, Full
Authorization for Import Budget Scenarios is required.

No Authorization: Users cannot open the Budget Scenarios - Setup window.

Import Budget Scenarios

Full Authorization: Users can import budget scenarios from one company into another.
To enable this authorization, Full Authorization for Budget Scenarios - Setup is required.

No Authorization: Users cannot import budget scenarios.

Budget Distribution Methods
- Setup

Full Authorization: Users can define new Budget Distribution Methods and update exist-
ing ones in the Budget Distribution Methods - Setup window.

Read Only: Users can view the Budget Distribution Methods - Setup window.

No Authorization: Users cannot open the Budget Distribution Methods - Setup window.

Budget

Full Authorization: Users can define and update budget amounts in the Budget - Setup
window.

Read Only: Users can view existing budgets in the Budget - Setup window.

No Authorization: Users cannot open the Budget - Setup window.
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Field Name

Description

Confirm Budget Deviation

Full Authorization: Users can confirm a warning message regarding budget deviation in
documents and journal entries (defined by choosing Administration |} System

Initialization > General Settings > Budget ] tab). Users can also add a document or a
journal entry that causes a deviation from the budget, as defined for the linked G/L ac-
count.

No Authorization: Users cannot confirm budget deviation warning messages.

Cost Accounting

Full Authorization: Users can access all windows and reports in the Cost Accounting
menu.

Read Only: Users can view windows related to the cost accounting functions, with the
exception of the Profit Center Report window.

No Authorization: Users cannot view any data related to cost accounting.

Dimensions

Full Authorization: Users can access and determine multiple dimensions.

This menu is available when the Use Multidimensions checkbox on the |} General
Settings # Cost Accounting dtab is selected.

To enable this authorization, Full Authorization for Cost Accounting is required.

Read Only: Users can only view the selected dimensions.
To enable this authorization, Read Only authorization for Cost Accounting is required.

No Authorization: Users cannot open this window

Cost Centers - Setup

Full Authorization: Users can define new cost centers and update existing ones.
Read Only: Users can view the cost centers defined in the company.

No Authorization: Users cannot open the Cost Centers - Setup window.

Distribution Rules - Setup

Full Authorization: Users can define new distribution rules and update existing ones.
Read Only: Users can view the distribution rules defined in the company.

No Authorization: Users cannot open the Distribution Rules - Setup window.

Table of Cost Centers and
Distribution Rules

Full Authorization: Users can display the Table of Cost Centers and Distribution Rules
window, add new cost centers, add new distribution rules, and make cost accounting
adjustments.

Read Only: Users can view the Table of Cost Centers and Distribution Rules window.

No Authorization: Users cannot open the Table of Cost Centers and Distribution Rules

window.

Cost Center Report Full Authorization: Users can open the Cost Center Report window.
No Authorization: Users cannot open this window.

Distribution Report Full Authorization: Users can open the Distribution Report window.

No Authorization: Users cannot open this window.

Cost Accounting Summary
Report

Full Authorization: Users can open the Cost Accounting Summary Report window.

No Authorization: Users cannot open this window.
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Field Name

Description

Budget Versus Cost
Accounting

® full Authorization: Users can open the Budget Versus Cost Accounting window.

® No Authorization: Users cannot open this window.

Accrual Types

e full Authorization: Users can display the Accrual Types window and update accrual

types.
® Read Only: Users can view the Accrual Types window.

e No Authorization: Users cannot open this window.

Cost Accounting
Reconciliation Report

e full Authorization: Users can open the Cost Accounting Reconciliation Report window.

e No Authorization: Users cannot open this window.

Journal Entry for Cost
Accounting Adjustment

® Full Authorization: Users can access the Journal Entry for Cost Accounting Adjustment
window and generate a journal entry.
To generate an adjustment journal entry, the authorization for a Journal Entry number-
ing series which is defined as Cost Accounting Adjustment Only through the Document
Numbering window is required.

e No Authorization: Users cannot open the Journal Entry for Cost Accounting Adjustment
window.

Cost Elements

e Full Authorization: Users can access the Cost Elements window, add new elements and
modify the existing ones.

® Read Only: Users can access the Cost Elements window.

e No Authorization: Users cannot open the Cost Elements window.

Financial Reports

e full Authorization: Users can access and generate all the Financial Reports in all the cat-
egories, such as the Trial Balance and the General Ledger reports.

e No Authorization: Users cannot access or generate any of the reports specified in this
submenu.

i Note

You can grant full authorization or no authorization to each individual report or globally
to a group of reports located in a certain menu. For example, grant Full Authorization
rights for the Aging menu to apply this authorization to both the Customer Receivables
Aging and the Vendor Liabilities Aging reports.

Electronic Reports

e full Authorization: Users can generate legal reports in electronic format that comply
with the conventional regulations of this country.
® Read Only: Users can view existing electronic reports.

e No Authorization: Users cannot generate legal reports in electronic format

i Note

Currently, Users can find electronic reports only in the Financials module of the UK and
DE localizations. The electronic report folders in the different modules are folders re-
served for electronic reports usage. If functions are added to an electronic report folder,
the folder appears in the Main Menu, otherwise, it remains hidden.
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Field Name

Description

Accounting

® full Authorization: Users can access and generate all the accounting reports, such as
General Ledger, 1099 Report, and Aging.

e No Authorization: Users cannot access and generate any of the reports located under
this submenu.

G/L Accounts and Business
Partners

® full Authorization: Users can run the G/L Accounts and Business Partners report.

® No Authorization: Users cannot generate this report.

General Ledger

® Full Authorization: Users can run the General Ledger report.

e No Authorization: Users cannot generate this report.

Aging
Customer Receivables Aging

Vendor Liabilities Aging

® Full Authorization: Users can access and generate the Aging reports.

e No Authorization for Aging: Users cannot access or generate the reports located under
this submenu.

Transaction Journal Report

e full Authorization: Users can run the Transaction Journal report.

® No Authorization: Users cannot generate this report.

Transaction Report by

e Full Authorization: Users can access the Transaction Report by Projects window and

Projects generate a transaction report by projects.
® No Authorization: Users cannot access the Transaction Report by Projects window.
Document Journal ® full Authorization: Users can run the Document Journal report.

e No Authorization: Users cannot generate this report.

Cash Flow Reference Report

® Full Authorization: Users can run the Cash Flow Reference report.

e No Authorization: Users cannot generate this report.

1099/1096 Report Relevant only for the United States localization.

® Full Authorization: Users can run the 1099 report.

® No Authorization: Users cannot generate this report.
Tax ® full Authorization: Users can run the tax reports.

e No Authorization: Users cannot generate these reports.
Tax Report ® full Authorization: Users can run the Tax report.

® No Authorization: Users cannot generate this report.

Commission Trade Tax
Invoice Journal - Selection
Criteria

Available in Russia only.

® Full Authorization: Users can access this window and run the report.

e No Authorization: Users cannot open this window.

Customer Open Document
List

Available in the United States and Germany only.

e full Authorization: Users can generate this crystal report.

® No Authorization: Users cannot access this report.
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Field Name

Description

Financial

Full Authorization: Users can access and generate all the financial reports, such as
Balance Sheet and Cash Flow.

No Authorization for Financial: Users cannot access or generate any of the reports lo-
cated under this submenu.

Balance Sheet

Full Authorization: Users can run the Balance Sheet report.

No Authorization: Users cannot generate this report.

Trial Balance

Full Authorization: Users can run the Trial Balance report.

No Authorization: Users cannot generate this report.

Profit and Loss Statement

Full Authorization: Users can run the Profit and Loss Statement report.

No Authorization: Users cannot generate this report.

Cash Flow

Full Authorization: Users can run the Cash Flow report.

No Authorization: Users cannot generate this report.

Include Projected Postings by
Others

Full Authorization: Users can view records created by other users in the Include
Projected Postings section of the Cash Flow - Selection Criteria window and in the Cash
Flow report.

No Authorization: Users cannot view records created by other users in the Include
Projected Postings section of the Cash Flow - Selection Criteria window or in the Cash
Flow report, even if they have Full Authorization for Cash Flow.

Statement of Cash Flows

Full Authorization: Users can run the Statement of Cash Flows report and adjust it.
Read Only: Users can only view the Statement of Cash Flows report

No Authorization: Users cannot generate this report.

Comparison

Full Authorization: Users can access and generate all the comparison reports, such as
Balance Sheet Comparison and Trial Balance Comparison.

No Authorization: Users cannot access or generate any of the reports located under
this submenu.

Balance Sheet Comparison

Full Authorization: Users can run the Balance Sheet Comparison report.

No Authorization: Users cannot generate this report.

Trial Balance Comparison

Full Authorization: Users can run the Trial Balance Comparison report.

No Authorization: Users cannot generate this report.

Profit and Loss Statement
Comparison

Full Authorization: Users can run the Profit and Loss Statement Comparison report.

No Authorization: Users cannot generate this report.

Budget Setup

Full Authorization: Users can access and generate all the budget-related reports, such
as Budget and Trial Balance Budget.

No Authorization: Users cannot access or generate any of the reports located under
this submenu.
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Field Name Description

Budget Report ® Full Authorization: Users can run the Budget report.

® No Authorization: Users cannot generate this report.

Balance Sheet Budget Report ®  Full Authorization: Users can run the Balance Sheet Budget report.

e No Authorization: Users cannot generate this report.

Trial Balance Budget Report e full Authorization: Users can run the Trial Balance Budget report.

e No Authorization: Users cannot generate this report.

Profit and Loss Statement ® Full Authorization: Users can run the Profit and Loss Statement Budget report.

Budget Report ® No Authorization: Users cannot generate this report.
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7 Opportunities Module Authorizations

The following modules and functions define the Opportunities authorizations:

Field Name

Description

Opportunities

Full Authorization: Users can enter all the functions specified in the Opportunities mod-
ule and make required changes or new settings. When adding a new stage, users can
choose whether to close a document which is linked to the previous stage. Closing the
document requires authorization for the Close Document function (in General
Authorizations).

Read Only: Users can view the data defined in all the functions specified in the
Opportunities module.

No Authorization: Users cannot access any option specified in the Opportunities mod-
ule.

i Note

If you select the Read Only authorization for the entire Opportunities module, the au-
thorizations for its child items without the Read Only option are automatically set to No
Authorization.

Opportunity

Full Authorization: Users can open the Opportunity window, add new sales opportuni-
ties, and modify existing opportunities.

Read Only: Users can view the Opportunity window.

No Authorization: Users cannot open the Opportunity window.

Gross Profit

Full Authorization: Users can update the Gross Profit % and Gross Profit Total fields.

No Authorization: Users cannot update the Gross Profit % and Gross Profit Total fields.

Special Opportunity

Full Authorization: Users can access the options under the Special Opportunity

Authorizations Authorizations submenu
e No Authorization: Users cannot access the options under the Special Opportunity
Authorizations submenu
Edit Closing Date ® full Authorization: Users can update the Closing Date field in the Opportunity window if
the opportunity status is Won or Lost.
This authorization is available only when Full Authorization is set to Opportunity.
e No Authorization: If users have full authorization for Opportunity but no authorization
for Edit Closing Date, the Closing Date field is disabled when the opportunity status is
Won or Lost,
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Field Name

Description

Remove Opportunity

Full Authorization: Users can remove an opportunity in either of the following ways:

o Inthe opportunity document, choose |} Data > Remove ] from the main menu.
o Inthe opportunity document, right click and choose Remove.

No Authorization:Users cannot remove an opportunity.

Opportunities Reports

Full Authorization: Users can access and generate all the sales opportunity reports,
such as management, general, and status reports.

No Authorization: Users cannot access or generate any of the reports located under
this submenu.

Electronic Reports

Full Authorization: Users can view and generate Electronic Reports
Read Only: Users can view Electronic Reports

No Authorization: Users cannot access Electronic Reports

Management Reports

Full Authorization: Users can access and generate all the management reports, such as
Opportunities Forecast; Opportunities Forecast Over Time; and Opportunities Statistics.

No Authorization: Users cannot access and generate any of these reports.

General Reports

Full Authorization: Users can access and generate all the general reports such as
Opportunities Report; Stage Analysis; and Information Source Distribution Over Time.

No Authorization: Users cannot access or generate any of these reports.

Status Reports

Full Authorization: Users can access and generate all status reports, such as Won
Opportunities, Lost Opportunities, My Open Opportunities, and My Closed
Opportunities.

No Authorization: Users cannot access or generate any of these reports.

Opportunities Pipeline

Full Authorization: Users can access and generate the Opportunities Pipeline report and
open the Dynamic Opportunity Analysis window and the Opportunity List window.

No Authorization: Users cannot access and generate this report.

Dynamic Opportunity
Analysis

Full Authorization: Users can access and run the Dynamic Opportunity Analysis report
(through the Go To main menu).

No Authorization: Users cannot use this function.

Opportunity List

Full Authorization: Users can open the Opportunity List window (by double clicking the
pipeline in the Opportunities Pipeline window).

No Authorization: Users cannot open this window.
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8 Sales - A/R Module Authorizations

The following authorizations are required to create a sales document:

e Authorization for the specific document (such as a sales order)

e Authorization for the required numbering series (if possible, define a numbering series as the default, per
user)

e Authorization for discount percentages, if you use special prices or if you update prices manually. You must
also define this at the row level.

e Authorization for price lists, especially if you update prices manually

e Authorization for row totals, especially if you update prices manually

e Authorization to modify the table layout, if required

The following modules and functions define the Sales - A/R authorizations

Field Name Description

Sales - A/R ® Full Authorization: Users can access all the windows and perform all the actions speci-
fied in the Sales - A/R module and make required changes or new settings.

e Read Only: Users can view the data defined in all the functions specified in the Sales -
A/R module.

e No Authorization: Users cannot access any option specified in the Sales - A/R module.

i Note

If you select the Read Only authorization for the entire Sales - A/R module, the authori-
zations for its child items without the Read Only option are automatically set to No
Authorization.

A default numbering series needs to be assigned to users for them to be able to open a
sales document.

Full authorization or read only authorization for the base document is required to copy a
base document to a target document.

Sales Blanket Agreement e full Authorization: Users can open the Sales Blanket Agreement window, add new blan-
ket agreements and modify the existing ones.

® Read Only: Users can view sales blanket agreements.

® No Authorization: Users cannot open the Sales Blanket Agreement window.
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Field Name Description

Blanket Agreement Status ® Full Authorization: Users can modify the Status field of a blanket agreement.
This authorization is available only when Full Authorization is set to Blanket Agreement
under Sales - A/R.

e No Authorization: Users cannot modify the Status field of a blanket agreement.

i Note
Note the following when managing approval processes for a blanket agreement:

® The blanket agreement generator in the approval process template needs full au-
thorization for Blanket Agreement Status in order to be able to modify the status
from Draft to To Be Approved, which triggers the Request for Approval.

® Once a blanket agreement is approved, the requester cannot modify the blanket
agreement status even with full authorization for Blanket Agreement Status.

Sales Quotation ® Full Authorization: Users can open the Sales Quotation window, add new documents,
and modify existing ones.

® Read Only: Users can view sales quotation documents.

e No Authorization: Users cannot open the Sales Quotation window.

Sales Order ® full Authorization: Users can open the Sales Order window, add new documents, and
modify the existing ones.
Full authorization for Procurement Confirmation Wizard and for Purchase Order under
Purchasing - A/P are required to activate the Procurement Confirmation Wizard from a
sales order.
® Read Only: Users can view sales order documents.

e No Authorization: Users cannot open the Sales Order window.

Delivery e full Authorization: Users can open the Delivery window, add new documents, and mod-
ify existing ones.
® Read Only: Users can view delivery documents.

e No Authorization: Users cannot open the Delivery window.

Return Request ® full Authorization: Users can open the Return Request window, add new documents,
and modify the existing ones.

® Read Only: Users can view return request documents.

® No Authorization: Users cannot open the Return Request window.

Return ® Full Authorization: Users can open the Return window, add new documents, and modify
the existing ones.
e Read Only: Users can view return documents.

e No Authorization: Users cannot open the Return window.
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Field Name

Description

A/R Down Payment Request

Full Authorization: Users can open the A/R Down Payment Request window, add new
documents, and modify the existing ones.
Full authorization for Incoming Payments is required to activate payment means.

Read Only: You can view A/R down payment request documents.

No Authorization: You cannot open the A /R Down Payment Request window.

A/R Down Payment Invoice

Full Authorization: Users can open the A/R Down Payment Invoice window, add new
documents, and modify existing ones. Users can also update the payment means in the
sales order.

Read Only: Users can view A/R Down Payment Invoice documents.

No Authorization: Users cannot open the A /R Down Payment Invoice window.

A/R Invoice

Full Authorization: Users can open the A/R Invoice window, add new documents, and
modify existing ones.

Read Only: Users can view A/R invoice documents.

No Authorization: Users cannot open the A/R Invoice window.

A/R Invoice + Payment

Full Authorization: Users can open the A/R Invoice + Payment window, add new docu-
ments, and modify existing ones.

This authorization is available only when Full Authorization is set to Incoming Payments.
Read Only: Users can view A/R invoice + Payment documents.

With no authorization for Incoming Payments, users can view the payment list by
choosing the Payment Means icon in the toolbar but cannot access the Incoming
Payments window.

No Authorization: Users cannot open the A/R Invoice + Payment window.

A/R Credit Memo

Full Authorization: Users can open the A/R Credit Memo window, add new documents,
and modify existing ones.

Read Only: Users can view A/R credit memo documents.

No Authorization: Users cannot open the A/R Credit Memo window.

A/R Reserve Invoice

Full Authorization: Users can open the A/R Reserve Invoice window, add new docu-
ments, and modify existing ones.

Read Only: Users can view A/R reserve invoice documents.

No Authorization: Users cannot open the A/R Reserve Invoice window.

Recurring Transactions

Full Authorization: Users can open the Recurring Transactions/Confirmation of
Recurring Transactions window and execute the recurring transactions.

Full authorization for the types of documents listed in the Transact. Type columniis re-
quired to execute the recurring transactions.

Full or read-only authorization for Recurring Transactions Templates is required to ac-
cess the Recurring Transactions - Templates window by choosing the Templates button
in the Confirmation of Recurring Transactions window.

Read Only: Users can view the Recurring Transactions window but cannot execute the
recurring transactions.

No Authorization: Users cannot open the Recurring Transactions window.
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Field Name

Description

Recurring Transactions
Templates

Full Authorization: Users can open the Recurring Transactions: Templates window to
create recurring transaction templates,

Read Only: Users can view the Recurring Transactions: Templates window.

No Authorization: Users cannot open the Recurring Transactions: Templates window.

Document Generation Wizard

Full Authorization: Users can access the document generation wizard and create docu-

ments.
Generating documents does not require authorization for base or target documents.

No Authorization: Users cannot use this function.

Available-to-Promise Check
(version for SAP HANA)

Full Authorization: Users can access the Available-to-Promise Check window.

No Authorization: Users cannot access the Available-to-Promise Check window.
This authorization is available only when the Enable Advanced Available to Promise

checkbox on the |} Document Settings > General } tab is selected.

Delivery Schedule
Management (version for
SAP HANA)

Full Authorization: Users can accessthe Delivery Schedule Management window.

No Authorization: Users cannot accessthe Delivery Schedule Management window.

Fixed Qty/Date (version for
SAP HANA)

Full Authorization: Users can select or deselect the Fixed Qty/Date checkbox in the

Delivery Schedule Details window. To access the window, right click on Qty in a sales or-

der to open the context menu.

No Authorization: Users cannot select or deselect the checkbox. It is disabled.

Document Draft

Full Authorization: Users can save a document as a draft (by choosing |} Save as Draft

or File > Save as Draft 1 in the context menu).

No Authorization: Users cannot save any document as a draft.

Document Drafts Report

Full Authorization: Users can open the Document Drafts Report window, open existing

drafts, modify them, and add them as genuine documents. Users can close or remove a

draft through the context menu.

Read Only: Users can open the Document Drafts Report window, open existing drafts,

modify them, and add them as genuine documents. Users can close or remove a draft

through the context menu.

No Authorization: Users cannot open the Document Drafts Report window.

i Note

In addition to full or read-only authorization for Document Drafts Report, authorization
for a document (sales order, delivery, etc.) is also required to access the draft docu-
ment.
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Field Name

Description

Remove Document Drafts

Full Authorization: Users can remove Document Drafts. To enable this authorization, full
authorization for Document Drafts Report is required.

No Authorization: Users cannot remove Document Drafts

i Note

If users have no authorization for Document Drafts Report but have full authorization for
Remove Document Drafts, they cannot remove the draft.

Document Printing ® Full Authorization: Users can print all the documents and reports in SAP Business One
and access the Document Printing window.
e No Authorization: Users cannot print documents, reports, or windows through SAP
Business One.
i Note
This authorization applies to all documents and reports. It is also required for sending
documents in e-mails, to fax and for preview, and exporting them to PDFs, text, unfor-
matted text and images.
Dunning Wizard ® Full Authorization: Users can access the Dunning Wizard, define required parameters,

and save them by choosing Save Selection Parameter and Exit on the Processing page
of the wizard.

To execute the other options on the Processing page, full authorization for Execute a
dunning run is required.

To print, e-mail or preview dunning letters, authorization for Document Printing is re-
quired.

No Authorization: Users cannot use this function.

Execute a dunning run

Full Authorization: Users can execute a dunning run in the Dunning Wizard.
Read Only: Users can run the Dunning Wizard. They can view executed dunning runs or
run the wizard and select Save Selection Parameter and Exit on the Processing page.

No Authorization: Users can run the Dunning Wizard. They can view executed dunning
runs or run the wizard and select Save Selection Parameter and Exit on the Processing

page.

Gross Profit Recalculation
Wizard

Full Authorization: Users can access and run the Gross Profit Recalculation Wizard.
Executing the wizard requires Full Authorization for Execute Gross Profit Recalculation
Run.

No Authorization: Users cannot access the Gross Profit Recalculation Wizard.

This feature is available when you manage a perpetual inventory system.

Execute Gross Profit
Recalculation Run

Full Authorization: Users can execute the Gross Profit Recalculation Wizard.

No Authorization: Users cannot execute the wizard. They can only save parameters or
save simulation.
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Field Name

Description

Sales Reports

Full Authorization: Users can access and generate all Sales Reports, add new docu-
ments and view the existing ones.

No Authorization: Users cannot open Sales Reports.

Electronic Reports

Full Authorization: Users can view and generate Electronic Reports
Read Only: Users can view Electronic Reports

No Authorization: Users cannot access Electronic Reports

Sales Analysis

Full Authorization: Users can run the Sales Analysis report.

No Authorization: Users cannot run this report.

Backorder - Selection Criteria

Full Authorization: Users can run the Backorder report.
Read Only: Users cannot generate the Backorder report.

No Authorization: Users cannot generate the Backorder report.

Blanket Agreement
Fulfillment Report

Full Authorization: Users can run the Blanket Agreement Fulfillment Report under Sales -
A/R.

No Authorization: Users cannot run the Blanket Agreement Fulfillment Report under
Sales - A/R.

View Related Blanket
Agreement from BP Master
Data

Full Authorization: Users can view a business partner's sales blanket agreements by

choosing |} You Can Also > View Related Sales Blanket Agreements } in the Business
Partner Master Data window.

No Authorization: Users cannot view the related sales blanket agreements.

Annual Sales Analysis (by
Quarter)

Full Authorization: Users can run the Annual Sales Analysis (by Quarter) Crystal report.

No Authorization: Users cannot run this report.

Monthly Customer Status
Report (version for Microsoft

SOL)

Full Authorization: Users can run the Monthly Customer Status Crystal report.

No Authorization: Users cannot run this report.

Monthly Customer Status
Report(version for SAP
HANA)

Full Authorization: Users can view and modify the Monthly Customer Statusreport

No Authorization: Users cannot access the report

Tax Only

Full Authorization: Users can select the Tax Only checkbox in a row on the Contents tab
of a sales document to mark the row for tax payments and not for other purposes.
The Tax Only checkbox is invisible by default. To display it, open Form Settings.

No Authorization: Users cannot select the Tax Only checkbox.

Change Row Amounts

Full Authorization: Users can change the price, discount, and line total of the contents in
adocument.

No Authorization: Users cannot change the price, discount, and line total of the con-
tents in a document. Those fields are disabled.
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Field Name

Description

Change Sales Employee ® full Authorization: Users can change the sales employee entered automatically in a
document (according to either the selected customer or the document owner) when
adding the document.

e No Authorization: Users cannot select a different sales employee for the document.

Sales Employee Update ® full Authorization: Users can change the sales employee selected in an existing docu-

ment.

e No Authorization: Users cannot change the sales employee in existing documents.

Confirm Credit Line Deviation

When a customer exceeds the credit limit (defined by choosing |} Business Partner Master
Data > Payment Terms 1 tab Credit Limit), the following warning message appears:
Customer has exceeded credit limit.

® full Authorization: Users can approve system messages regarding the deviation from
the credit limit by clicking Yes, thus enabling the customer to exceed the credit limit.

® No Authorization: Users cannot approve such actions.

Confirm Debt Line Deviation

When a customer deviates from the commitment limit (defined for each customer by
choosing |} Business Partner Master Data > Payment Terms 1 tab Max. Commitment), the
following warning message appears:

Customer has exceeded commitment limit.

e full Authorization: Users can approve system messages regarding deviation from the
commitment limit by clicking Yes, thus enabling the customer to deviate from the com-
mitment limit.

e No Authorization: Users cannot approve such actions.

Confirm Stock Limit

Deviation

If, during stock issue, inventory falls below the minimum level defined in Item Master Data,
the following warning message appears:

Inventory is under minimum per Item.

This warning is defined by choosing |} Document Settings > General } tab |} When
Attempting to Release Stock Below the Minimum Level > Warning Only ]),

A warning message also appears when inventory falls below the minimum in goods issue
and inventory transfer documents.

If the receipt of stock makes the inventory quantity higher than the maximum quantity level
defined in Iltem Master Data, the following warning message appears:

Quantity exceeds maximum inventory level.

® Full Authorization: Users can approve system messages regarding deviation from the
minimum/ maximum stock level by clicking Yes, allowing the stock to fall below the
minimum or exceed the maximum.

® No Authorization: Users cannot approve such actions.
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Field Name

Description

Partial Delivery

Users can select or deselect the Allow Partial Delivery in Sales Orders checkbox on the

Logisticstab. This determines whether the sales order can be copied partially to a target

document. To set the default, choose |} Business Partner Master Data > Payment Terms }

tab.

Full Authorization: Users can select or deselect the Partial Delivery checkbox in sales or-
ders.

No Authorization: Users cannot change this definition in the document. The Allow
Partial Delivery checkbox is disabled.

Document Confirmation

Users can select or deselect the Approved checkbox on the Logisticstab in sales and pur-

chase orders and in sales and purchase return requests. This determines whether these

documents are approved for being copied to a target document. To set the default, choose

|} Administration > System Initialization > Document Settings > Per Document ]tab Sales
Order/Purchase Order.

Full Authorization: Users can select or deselect the Approved checkbox in sales orders
and in purchase orders.

No Authorization: Users cannot change this definition in the document. The Approved
checkbox is disabled.

Documents with Zero
Amounts

Users can add sales and purchasing documents with a zero total amount (the value in the
Total field is O).

Full Authorization: Users can add documents with a zero total amount.

No Authorization: Users cannot add such documents.

Allow to Change
Reconciliation Accounts

Full Authorization: Users can select or deselect the Permit Change of Control Accounts
checkbox (|} Administration > Setup > Financials > G/L Account Determination >
Sales/Purchase 4 tab).

No Authorization: Users cannot change this definition. The Permit Change of Control
Accounts checkbox is disabled.

Gross Profit

Full Authorization: Users can open the Gross Profit window and modify relevant data.
Read Only: Users can view the Gross Profit window.

No Authorization: Users cannot open the Gross Profit window. In addition, gross profit
datais not displayed in reports (such as Sales Analysis) generated by a user with no
authorization.

Change Tax Rate

Available in Israel only, where the tax rate is managed at company level.

Full Authorization: Users can change the default company tax rate when they add a new
marketing document or when they copy an existing marketing document to another
document.

No Authorization: Users cannot change the default company tax rate in marketing
documents. It is read-only.
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Field Name Description

Modify Posted A/R e full Authorization: Users can modify fields at the row level after the sales documents
have been posted. For example, the owner can be modified in a row in a sales document
that creates a journal entry (such as an invoice) or inventory transaction only (such as a
delivery in a non-perpetual inventory system) after the document has been posted.

Documents

® No Authorization: Users cannot modify any field at the row level after the sales docu-

ment has been posted.

Update User-Defined Fields in  This authorization is available when the checkbox Allow Update of User-Defined Fields When
Not Editable Rows Document Rows Are Not Editable on the |} Document Settings > Per Document 1 tabis se-
lected.
® Full Authorization: Users can update user-defined fields after a marketing document is
added or closed.
® No Authorization: User cannot update user-defined fields after a marketing document

is added or closed.
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9 Purchasing - A/P Module Authorizations

In general, the following authorizations are required to create a purchasing document:

e Authorization for the specific document (such as a purchase order)

e Authorization for the required numbering series (if possible, define a numbering series as the default, per
user)

e Authorization for discount percentages, if special prices are used or if the customer changes prices
manually. This must also be defined at the row level.

e Authorization for price lists, especially if prices are updated manually
e Authorization for row totals, especially if prices are updated manually
e Authorization to modify the table layout, if required

The following modules and functions define the Purchasing - A/P authorizations:

Field Name Description

Purchasing - A/P ® Full Authorization: Users can access all the windows and perform all the actions speci-
fied in the Purchasing - A/P module and make required changes or new settings.
® Read Only: Users can view the data defined in all the functions specified in the
Purchasing - A/P module.
e No Authorization: Users cannot access any of the options in the Purchasing - A/P mod-
ule.

i Note

If you select the Read Only authorization for the entire Purchasing - A/P module, the au-
thorizations for its child items without the Read Only option are automatically set to No
Authorization.

Blanket Agreement e full Authorization: Users can open the Purchase Blanket Agreement window, add new
blanket agreements and modify the existing ones.
® Read Only: Users can view purchase blanket agreements.

e No Authorization: Users cannot open the Purchase Blanket Agreement window.

How to Define Authorizations in SAP Business One 10.0
Purchasing - A/P Module Authorizations PUBLIC 71



Field Name

Description

Blanket Agreement Status

Full Authorization: Users can modify the Status field of a blanket agreement.
This authorization is available only when Full Authorization is set to Blanket Agreement
under Purchase - A/P.

No Authorization: Users cannot modify the Status field of a blanket agreement.

i Note

When managing Approval Process for blanket agreement:

® The blanket agreement generator in the approval process template, shall have full
authorization for Blanket Agreement Status in order to be able to modify the status
from Draft into To Be Approved (which triggers the Request for Approval).

® Once a blanket agreement is approved, the requester cannot modify the blanket
agreement status even with full authorization for Blanket Agreement Status.

Purchase Request

Full Authorization: Users can open the Purchase Request window, add new documents,
and modify the existing ones.

Read Only: Users can view Purchase Request documents.

No Authorization: Users cannot open the Purchase Request window.

Requester Change

Full Authorization: Users can change the requester code (user/employee) of an existing
purchase request.

No Authorization: Users cannot change the requester code of an existing purchase re-
quest.

Purchase Quotation

Full Authorization: Users can open the Purchase Quotation window, add new docu-
ments, and modify existing ones.

Read Only: Users can view Purchase Quotation documents.

No Authorization: Users cannot open the Purchase Quotation window.

Purchase Order

Full Authorization: Users can open the Purchase Order window, add new documents,
and modify existing ones. In addition, you are granted full authorization for the Split
Purchase Order function.

Read Only: Users can view purchase order documents. In addition, you are granted read
only authorization for the Split Purchase Order function.

No Authorization: Users cannot open the Purchase Order window.

Split Purchase Order

Full Authorization: Users can select and deselect the Split Purchase Order checkbox on
the Logistics tab in a purchase order.

No Authorization: The Split Purchase Order checkbox is disabled.

Goods Receipt PO

Full Authorization: Users can open the Goods Receipt PO window, add new documents,
and modify the existing ones.

Read Only: Users can view Goods Receipt PO documents.

No Authorization: Users cannot open the Goods Receipt PO window.
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Field Name

Description

Goods Return Request

Full Authorization: Users can open the Goods Return Request window, add new docu-
ments, and modify the existing ones.

Read Only: Users can view Goods Return Request documents.

No Authorization: Users cannot open the Goods Return Request window.

Goods Return

Full Authorization: Users can open the Goods Return window, add new documents, and
modify existing ones.

Read Only: Users can view Goods Return documents.

No Authorization: Users cannot open the Goods Return window.

A/P Down Payment Invoice

Full Authorization: Users can open the A/P Down Payment Invoice window, add new
documents, and modify existing ones.
Read Only: Users can view A/P Down Payment Invoice documents.

No Authorization: Users cannot open the A/P Down Payment Invoice window.

A/P Invoice

Full Authorization: Users can open the A/P Invoice window, add new documents, and
modify existing ones.

Read Only: Users can view A/P invoice documents.

No Authorization: Users cannot open the A/P Invoice window.

A/P Credit Memo

Full Authorization: Users can open the A/P Credit Memo window, add new documents,
and modify existing ones.

Read Only: Users can view A/P Credit Memo documents.

No Authorization: Users cannot open the A/P Credit Memo window.

A/P Reserve Invoice

Full Authorization: Users can open the A/P Reserve Invoice window, add new docu-
ments and modify existing ones.

Read Only: Users can view A/P Reserve Invoice documents.

No Authorization: Users cannot open the A/P Reserve Invoice window.

Landed Costs

Full Authorization: Users can open the Landed Costs window, add new documents and
modify existing ones.
Read Only: Users can view Landed Costs documents.

No Authorization: Users cannot open the Landed Costs window.

Folio Numbering - Editing

Full Authorization: Users can edit the folio numbers by choosing Edit Folio Numbers in
the context menu of a document.

No Authorization: Users cannot edit the folio numbers.

Procurement Confirmation
Wizard

Full Authorization: Users can access the Procurement Confirmation Wizard and create
purchase documents directly from sales orders (providing you have an authorization
for the purchase documents).

No Authorization: Users cannot open or view the wizard.
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Field Name

Description

Purchase Quotation
Generation Wizard

Full Authorization: Users can access the Purchase Quotation Generation Wizard and cre-
ate a batch of purchase quotations automatically.

No Authorization: Users cannot open or view the wizard.

Change Tax Amount
Distribution

Relevant only for the United States localization

Users can access the Define Tax Amount Distribution window, opened from the Tax Amount

(LC) field in sales and purchasing documents or by choosing the Add Expenses field

|) Expenses window > Total Tax Amount 1fie|d.

Full Authorization: Users can open the Define Tax Amount Distribution window and
change the distribution of the tax amount.

Read Only: Users can view the Define Tax Amount Distribution window.

No Authorization: Users cannot open the Define Tax Amount Distribution window.

Purchasing Reports

Full Authorization: Users can open Purchasing Reports.

No Authorization: Users cannot open Purchasing Reports.

Electronic Reports

Full Authorization: Users can view and generate Electronic Reports
Read Only: Users can view Electronic Reports

No Authorization: Users cannot access Electronic Reports

Purchase Analysis

Full Authorization: Users can view and access Purchase Analysis documents.

No Authorization: Users cannot access the window.

Purchase Request Report

Full Authorization: Users can open the Purchase Request Report, create target docu-
ments and view existing ones.

No Authorization: Users cannot open Purchase Request Report.

Quotation Comparison

Full Authorization: Users can open the Quotation Comparison, add new documents and
view existing ones.

No Authorization: Users cannot open or view the Quotation Comparison.

Blanket Agreement ® Full Authorization: Users can run the Blanket Agreement Reports.
e No Authorization: Users cannot run the Blanket Agreement Reports.
Blanket Agreement ® Full Authorization: Users can run the Blanket Agreement Fulfillment Report under

Fulfillment Report

Purchase - A/P.

No Authorization: Users cannot run the Blanket Agreement Fulfillment Report under
Purchase - A/P.

View Related Blanket
Agreement from BP Master
Data

Full Authorization: Users can view a business partner's purchase blanket agreements by
choosing |} You Can Also > View Related Purchase Blanket Agreements ] inthe
Business Partner Master Data window.

No Authorization: Users cannot view the related purchase blanket agreements.
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Field Name Description

Tax Only ® full Authorization: Users can select the Tax Only checkbox to mark a row in a purchas-
ing document for tax payments and not for other purposes.
The Tax Only checkbox is invisible by default. To display it, open Form Settings

e No Authorization: Users cannot select the Tax Only checkbox.

Modify Posted A/P ® full Authorization: Users can modify fields at the row level after the purchasing docu-
Documents ments have been posted. For example, the owner can be modified in a row in a docu-
ment that creates a journal entry or inventory transaction, such as a goods receipt PO,
after the document has been posted.
® No Authorization: Users cannot modify any field at the row level in a purchasing docu-
ment once it has been posted.

How to Define Authorizations in SAP Business One 10.0
Purchasing - A/P Module Authorizations PUBLIC 75



10 Business Partners Module Authorizations

The following modules and functions define the Business Partners authorizations:

Field Name

Description

Business Partners

e full Authorization: Users can access all the windows and perform all the actions speci-
fied in the Business Partners module and make required changes or new settings.

® Read Only: Users can view the data defined in all the functions specified in the Business
Partners module.

e No Authorization: Users cannot access any option specified in the Business Partners
module.

i Note

If you select the Read Only authorization for the entire Business Partners module, the
authorizations for its child items without the Read Only option are automatically set to
No Authorization.

Adding Business Partner

® full Authorization: Users can add business partner master data from all business part-
ner types: Customer, Vendor and Lead. In addition, you require Read Only authorization
for price lists.

e No Authorization: Users cannot add business partners.

Adding Customer/Vendor e full Authorization: Users can add Customer and Vendor business partner master data.
Master Data ® No Authorization: Users cannot add Customer and Vendor business partners.
Adding Lead BP e full Authorization: Users can add Lead business partner master data.

® No Authorization: Users cannot add Lead business partners.

Business Partner Master Data

e full Authorization: Users can open and work in the Business Partner Master Data win-
dow, modify and view data, and perform all the actions specified in this section, such as
Sales Order Balance.

® Read Only: Users can view the Business Partner Master Data window. If you select Read
Only, all the options listed in this section (such as Delivery Balance) are set to No
Authorization.

e No Authorization: Users cannot open the Business Partner Master Data window.

Sales Order Balance

e full Authorization: Users can view the sales order balance of the business partner in the
Orders field.

e No Authorization: Users see asterisks (****) instead of numbers.

Delivery Balance

® Full Authorization: Users can view the delivery balance of the business partner in the
Deliveries field.

e No Authorization: Users see asterisks (****) instead of numbers.
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Field Name Description

Open Check Balance e full Authorization: Users can see the Checks field in the Business Partner Master Data
window and open the Check Balance window.
e No Authorization: Users cannot see the Checks field in the Business Partner Master
Data window or access the Check Balance window.

Goods Receipt PO Balance ® full Authorization: Users can view the delivery balance of a business partner in the
Goods Receipt PO Balance field.

e No Authorization: Users see asterisks (****) instead of numbers.

Purchase Order Balance ® Full Authorization: Users can view the delivery balance of the business partner in the
Purchase Order Balance field.

® No Authorization: Users see (****) asterisks instead of numbers.

Change Sales Employee ® Full Authorization: Users can change the specified sales employee by choosing

|} Business Partner Master Data > General } tab.

e No Authorization: Users cannot change the sales employee.

General Tab e full Authorization: Users can view and edit the data on the General tab in the Business
Partner Master Data window, unless they have no authorization for a specific field on
the tab.

e Read Only: Users can view but cannot edit the data on the General tab in the Business
Partner Master Data window.

® No Authorization: The General tab in the Business Partner Master Data window is hid-
den.

Contact Persons Tab e full Authorization: Users can view and edit the data on the Contact Persons tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

® Read Only: Users can view but cannot edit the data on the Contact Persons tab in the
Business Partner Master Data window.

® No Authorization: The Contact Persons tab in the Business Partner Master Data window
is hidden.

Addresses Tab e Full Authorization: Users can view and edit the data on the Addresses tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

® Read Only: Users can view but cannot edit the data on the Addresses tab in the
Business Partner Master Data window.

® No Authorization: The Addresses tab in the Business Partner Master Data window is hid-
den.

How to Define Authorizations in SAP Business One 10.0
Business Partners Module Authorizations PUBLIC 77



Field Name

Description

Payment Terms Tab

Full Authorization: Users can view and edit the data on the Payment Terms tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

Read Only: Users can view but cannot edit the data on the Payment Terms tab in the
Business Partner Master Data window.

No Authorization: The Payment Terms tab in the Business Partner Master Data window
is hidden.

Payment Run Tab

Full Authorization: Users can view and edit the data on the Payment Run tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

Read Only: Users can view but cannot edit the data on the Payment Run tab in the
Business Partner Master Data window.

No Authorization: The Payment Run tab in the Business Partner Master Data window is
hidden.

Accounting Tab

Full Authorization: Users can view and edit the data on the Accounting tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

Read Only: Users can view but cannot edit the data on the Accounting tab in the
Business Partner Master Data window.

No Authorization: The Accounting tab in the Business Partner Master Data window is
hidden.

Intrastat Settings Tab

Full Authorization: Users can view and edit the data on the Intrastat Settings tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

Read Only: Users can view but cannot edit the data on the Intrastat Settings tab in the
Business Partner Master Data window.

No Authorization: The Intrastat Settings tab in the Business Partner Master Data win-
dow is hidden.

i Note

The authorization for Intrastat Settings Tab will be updated to no authorization
when no authorization is selected for General Tab.

The authorization for General Tab will be updated to read-only when full or read-
only authorization is selected for Intrastat Settings Tab.

Properties Tab

Full Authorization: Users can view and edit the data on the Properties tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

Read Only: Users can view but cannot edit the data on the Properties tab in the
Business Partner Master Data window.

No Authorization: The Properties tab in the Business Partner Master Data window is hid-
den.
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Field Name Description

Remarks Tab °

Full Authorization: Users can view and edit the data on the Remarks tab in the Business
Partner Master Data window, unless they have no authorization for a specific field on
the tab.

Read Only: Users can view but cannot edit the data on the Remarks tab in the Business
Partner Master Data window.

No Authorization: The Remarks tab in the Business Partner Master Data window is hid-
den.

Attachments Tab °

Full Authorization: Users can view and edit the data on the Attachments tab in the
Business Partner Master Data window, unless they have no authorization for a specific
field on the tab.

Read Only: Users can view but cannot edit the data on the Attachments tab in the
Business Partner Master Data window.

No Authorization: The Attachments tab in the Business Partner Master Data window is
hidden.

eDocs Tab i

Full Authorization: Users can view and edit the data on the eDocs tab in the Business
Partner Master Data window, unless they have no authorization for a specific field on
the tab.

Read Only: Users can view but cannot edit the data on the eDocs tab in the Business
Partner Master Data window.

No Authorization: The eDocs tab in the Business Partner Master Data window is hidden.

Tabs in Web Client for SAP °

Business One

Full Authorization: Users can view and edit the data on the tabs in the Business Partner
detailed view in Web Client for SAP Business One specified in this section, unless they
have no authorization for a specific field on the tabs.

Read Only: Users can view but cannot edit the data on the tabs in the Business Partner
detailed view in Web Client for SAP Business One specified in this section.

No Authorization: The tabs in the Business Partner detailed view in Web Client for SAP
Business One specified in this section are hidden.

Additional Data Tab e full Authorization: Users can view and edit the data on the Additional Data tab in the
Business Partner detailed view, unless they have no authorization for a specific field on
the tab.

® Read Only: Users can view but cannot edit the data on the Additional Data tab in the
Business Partner detailed view.

e No Authorization: The Additional Data tab in the Business Partner detailed view is hid-
den.

Active Users can set an activity period for the business partner. When this activity period is over, it

is not possible to create documents for this business partner.

Full Authorization: Users can select or deselect the Active checkbox (|} Business
Partner Master Data > General 1 tab). When the checkbox is selected, three additional
fields are displayed, letting you define the activity period and enter comments.

No Authorization: Users cannot set an activity period for a business partner.
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Field Name

Description

Inactive

Full Authorization: Users can select or deselect the Inactive checkbox (|} Business
Partner Master Data > General ] tab). When the checkbox is selected, three additional
fields are displayed, letting you define the inactive period and enter comments.

No Authorization: Users cannot set an inactive period for a business partner.

Remove Business Partner

Full Authorization: Users can remove a business partner (from the context menu; or the

menu bar, choose |} Data > Remove Business Partner }).

No Authorization: Users cannot remove a business partner.

Verify VAT Numbers

Full Authorization: Users can verify VAT numbers for business partners using the Verify
VAT Numbers option through the You Can Also button in the Business Partner Master
Data window.

No Authorization: Users cannot verify VAT numbers..

i Note

This entry only appears when the Verify VAT Numbers for Business Partners and
Documents checkbox on the BP tab in the General Settings window is selected.

Campaign Generation Wizard

Full Authorization: Users can access the Campaign Generation Wizard, create a new
campaign, save it, and load the saved campaign.

No Authorization: Users cannot access the wizard.

Execute Campaign

Full Authorization: Users can execute the Campaign Generation Wizard on condition
that they have authorization for Campaign Generation Wizard.

No Authorization: If users have full authorization for Campaign Generation Wizard but
no authorization for Execute Campaign, they can access the wizard, create a new cam-
paign, save it and load the saved campaign, but they cannot execute the campaign.

Campaign

Full Authorization: Users can open the Campaign window, add new campaigns, and
modify existing ones.

Read Only: Users can view the Campaign window.

No Authorization: Users cannot open the Campaign window.

Business Partner Type

Full Authorization: Users can search for and view specific types of business partners.

No Authorization: Users cannot search for specific types of business partners.

Customers, Vendors, Leads

Full Authorization: Users can search for and view specific types of business partners.

No Authorization: Users cannot search for specific types of business partners.

Activity

Full Authorization: Users can open the Activity window, add new activities, and modify
existing ones.

Read Only: Users can view the Activity window.

No Authorization: Users cannot open the Activity window.
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Field Name

Description

Delete Activity

Full Authorization: Users can delete an existing activity by the context menu or by

choosing |} Data > Remove ]

No Authorization: Users cannot delete activities.

Internal Reconciliations

Full Authorization: Users can display, cancel, and recreate internal reconciliations cre-
ated for a specified range of business partners, and manage previous internal reconcili-
ations.

Read Only: Users can view the Reconciliation and Manage Previous Reconciliations win-
dows but not make any changes.

No Authorization: Users cannot view these windows.

Reconciliation

Full Authorization: Users can display, cancel, and recreate internal reconciliations cre-
ated for a specified range of business partners.

Read Only: Users can view the Reconciliation window but cannot make any changes.

No Authorization: Users cannot view this window.

Manage Previous
Reconciliations

Full Authorization: Users can display, cancel, and recreate internal reconciliations cre-
ated for a specified range of business partners.

Read Only: Users can view the Manage Previous Reconciliations window but cannot
make any changes.

No Authorization: Users cannot view this window.

Business Partner Reports

Full Authorization: Users can open and run all the business partner reports. In addition,
you require full authorization for BP Balances, Account Balances, Accounting and
Access to Confidential Accounts fields. These are set in General Authorizations module
Authorizations. To print these reports, you require full authorization for the Document
Printing field.

No Authorization: Users cannot run these reports.

Electronic Reports

Full Authorization: Users can view and generate Electronic Reports
Read Only: Users can view Electronic Reports

No Authorization: Users cannot access Electronic Reports

Activities Overview

Full Authorization: Users can open and run all activityreports: My Activities, Activities
Overview and Activity Check in Report (available in SAP Business One, version for SAP
HANA only).

No Authorization: Users cannot run these reports.

Inactive Customers

Full Authorization: Users can open and run the Inactive Customers report.

No Authorization: Users cannot run this report.

Dunning History Report Full Authorization: Users can open and run the Dunning History report.
No Authorization: Users cannot run this report.
Campaigns List Full Authorization: Users can open and run the Campaigns List report.

No Authorization: Users cannot run this report.

How to Define Authorizations in SAP Business One 10.0

Business Partners Module Authorizations

PUBLIC 81



Field Name Description

Sent Emails Report ® full Authorization: Users can open and run the Sent Emails Report.

® No Authorization: Users cannot run this report.
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11 Banking Module Authorizations

The following modules and functions define the Banking authorizations:

Field Name

Description

Banking

e full Authorization: Users can access all the windows and perform all the actions speci-
fied in the Banking module and make required changes or new settings.

® Read Only: Users can view the data defined in all the functions specified in the Banking
module.

e No Authorization: Users cannot access any option specified in the Banking module.

i Note

If you select the Read Only authorization for the entire Banking module, the authoriza-
tions for its child items without the Read Only option are automatically set to No
Authorization.

Incoming Payments

® Full Authorization: Users can open all the windows located under the Incoming
Payments submenu, add new incoming payment documents, view the Check Register
window, Credit Card Management window, Credit Card Summary window and perform
various actions.

® Read Only: Users can view windows located under the Incoming Payments submenu.

e No Authorization: Users cannot open any of the windows located under the Incoming
Payments submenu.

Incoming Payments

e full Authorization: Users can open the Incoming Payments window, add new incoming
payment documents, and modify existing ones.

® Read Only: Users can view the Incoming Payments window.

e No Authorization: Users cannot open the Incoming Payments window.

Cash Receipt ® full Authorization: Users can use cash as the payment means (|} Incoming Payments >
Payment Means > Cash }tab).
e No Authorization: Users cannot use cash as the payment means in incoming payments.
Check Register ® Full Authorization: Users can open the Check Register window, view check data, update
due dates, endorse and cancel checks, and cancel deposits and payments.
® Read Only: Users can view the Check Register window.
e No Authorization: Users cannot open the Check Register window.
Credit Card Management e full Authorization: Users can open the Credit Card Management window, view credit

card vouchers data, update references, and cancel credit card vouchers.
® Read Only: Users can view the Credit Card Management window

e No Authorization: Users cannot open the Credit Card Management window
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Field Name

Description

Deposits Full Authorization: Users can open the Deposit window and deposit checks, credit card
vouchers, and cash to the bank or to a business partner. In addition, Users can view
previous deposits, modify their data, and even cancel deposits. This authorization also
includes access to the Postdated Credit Voucher window and the ability to deposit post-
dated checks.

Read Only: Users can view the Deposit window.
No Authorization: Users cannot open the Deposit window.

Deposit Full Authorization: Users can open the Deposit window and deposit checks, credit card
vouchers, and cash to the bank or to a business partner. In addition, Users can view
previous deposits, modify their data, and even cancel deposits.

Read Only: Users can view the Deposit window.
No Authorization: Users cannot open the Deposit window.

Outgoing Payments Full Authorization: Users can open all the windows located under the Outgoing
Payments submenu, add new outgoing payment documents, process and view checks
for payment, perform actions in the Void Checks for Payment window, and open the
Checks for Payments Draft Report.

Read Only: Users can view the windows located under the Outgoing Payments sub-
menu.

No Authorization: Users cannot open any of the windows located under the Outgoing
Payments submenu.

Outgoing Payments Full Authorization: Users can open the Outgoing Payments window, add new outgoing
payment documents, and modify existing ones.

Read Only: Users can view the Outgoing Payments window.
No Authorization: Users cannot open the Outgoing Payments window.

Payment Draft Full Authorization: Users can save a payment as a draft
No Authorization: Users cannot save a payment as a draft

Checks for Payment Full Authorization: Users can open the Checks for Payment window, add new checks for
payment documents, modify the existing ones and cancel checks.

This authorization also determines the ability to access the Check Register Report un-
derl} Banking > Banking Reports. ]

Read Only: Users can view the Checks for Payment window.

No Authorization: Users cannot open the Checks for Payment window.

Void Checks for Payment Full Authorization: Users can open the Void Checks for Payment window, void required

checks, and reprint them.
i Note
Make sure that you have authorizations for Numbering Series.
Read Only: Users can view the Void Checks for Payment window.
No Authorization: Users cannot open the Void Checks for Payment window
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Field Name

Description

Update Pay To

Full Authorization: Users can change Pay to in the Checks for Payment window

No Authorization: Users cannot change Pay to in the Checks for Payment window

Create Check for Payment
Without Journal Entry

Full Authorization: Users can deselect Create Journal Entry in the Checks for Payment
window to create a check for payment without a journal entry.

No Authorization: Users cannot deselect Create Journal Entry in the Checks for
Payment window.

Print Check for Payment Full Authorization: Users can print a check for payment from the check itself and from
Document Printing.
No Authorization: Users cannot print a check for payment from the check itself or from
Document Printing.

Print Voided Checks for Full Authorization: Users can print voided checks for payment.

Payment No Authorization: Users cannot print voided checks for payment.

Reprint Check for Previously

Printed Payment

Full Authorization: Users can print a check that was already printed

No Authorization: Users cannot print any check that was already printed

Payment Drafts Report

Full Authorization: Users can open the Payment Drafts Report window, open existing
drafts, modify them, and add them as genuine documents.

No Authorization: Users cannot open the Payment Drafts Report window.

i Note

The Payment Drafts Report authorization applies to both incoming and outgoing pay-
ments.

View Incoming Payment
Drafts Created by Other
Users

Full Authorization: Users can view incoming payment drafts created by other users in
the Payment Drafts Report window.

No Authorization: Users cannot view incoming payment drafts created by other users in
the Payment Drafts Report window.

View Outgoing Payment
Drafts Created by Other
Users

Full Authorization: Users can view outgoing payment drafts created by other users in
the Payment Drafts Report window.

No Authorization: Users cannot view outgoing payment drafts created by other users in
the Payment Drafts Report window.

Remove Payment Drafts

Full Authorization: Users can remove payment drafts from the Payment Drafts Report
window.
No Authorization: Users cannot remove payment drafts from the Payment Drafts Report

window.

Checks for Payment Draft

Full Authorization: Users can save checks for payment as drafts.

No Authorization: Users cannot save checks for payment as drafts.
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Field Name

Description

Checks for Payment Drafts
Report

Full Authorization: Users can open the Payment Drafts Report window, open existing
drafts, modify them, and add them as genuine documents.

Read Only: Users can view the Checks for Payment Drafts Report window.

No Authorization: Users cannot open the Payment Drafts Report window.

Remove Checks for Payment
Drafts

Full Authorization: Users can remove Checks for Payment Drafts from the Checks for
Payment Drafts Report window.

No Authorization: Users cannot remove Checks for Payment Drafts from the Checks for
Payment Drafts Report window.

Payment System Full Authorization: Users can run the Payment Wizard, access all its related definitions,
and execute payment runs.

No Authorization: Users cannot work with the payment wizard.

Payment Wizard Full Authorization: Users can work with the Payment Wizard and execute payment runs.
Full authorization for Execute is required to enable the Execute Payment Run option in
the Save Options step of the wizard.

No Authorization: Users cannot work with the payment wizard.
Execute Full Authorization: Users can execute payment runs by selecting the Execute Payment

Run option in the payment wizard when they have full authorization for Payment
Wizard.

No Authorization: Users cannot execute the wizard. The Execute Payment Run option is
hidden.

i Note

This authorization is not applicable to Execute Payment Order.

Payment Engine - Bank File
Generation

Full Authorization: Users can generate a bank file by selecting Bank File in the step
Payment Run Summary and Printing of the Payment Wizard when they have full authori-
zation for the wizard.

No Authorization: Users cannot generate bank files.

Payment Orders

Full Authorization: Users can access Payment Orders under Banding and print payment
orders.

Full Authorization for Documents Printing under Sales - A/R is required for printing pay-
ment orders.

No Authorization: Users cannot access Payment Orders.
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Field Name

Description

Bank Statements and
External Reconciliations

Full Authorization: Users can open all the windows specified in the Bank Statements and

Reconciliations submenu and perform various actions.

Read Only: Users can only view the Bank Statement Summary window.

i Note

This option applies only in certain localizations and is relevant when the Install
Bank Statement Processing checkbox on the Basic Initialization tab of the

|} Administration > System Initialization > Company Details }window is selected.

No Authorization: Users cannot open any of the windows located under the Bank
Statements and Reconciliations submenu.

Bank Statement Summary

Full Authorization: Users can access Bank Statement Summary via Bank Statement
Processing and view and process bank statement details.

Read Only: Users can view bank statement details

No Authorization: Users cannot access Bank Statement Processing.

i Note
The entry Bank Statement Processing is available when the Install Bank Statement
Processing checkbox on the Basic Initialization tab in the |} Administration > System

Initialization > Company Details ]window is selected.

Process External Bank
Statement

Full Authorization: Users can access the Process External Bank Statement window, add

new bank statements, or update the existing ones.

No Authorization: Users cannot open this window.

i Note

This functionality is available when the Install Bank Statement Processing checkbox on
the Basic Initialization tab in the |} Administration > System Initialization > Company

Details }Window is deselected.

In some localizations (for example, Polish), the window name is Statement Evidence.

Bank Statement Information

Full Authorization: Users can access Bank Statement Information under Banking
Reports.

No Authorization: Users cannot access Bank Statement Information.

Reconciliation

Full Authorization: Users can access the Reconciliation window and reconcile open
transactions with open bank statement transactions.

No Authorization: Users cannot open this window.
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Field Name

Description

External Bank Reconciliation

Full Authorization: Users can access the Manual Reconciliation window and check/clear
open transactions against bank statement transactions.

No Authorization: Users cannot open this window.

i Note
This functionality is available when the Install Bank Statement Processing checkbox on
the Basic Initialization tab in the |} Administration > System Initialization > Company

Details ]window is deselected.

Manage Previous External
Reconciliations

Full Authorization: Users can access the Manage Previous Reconciliations window and
view and cancel reconciliations.

No Authorization: Users cannot open this window.

Check and Restore Previous
External Reconciliations

Full Authorization: Users can access the Check and Restore Previous Reconciliations
window and open and restore reconciliations.

No Authorization: Users cannot open this window.

Check Number Confirmation

Full Authorization: Users can access the Check Number Confirmation window and
change the Status column.

Read Only: Users can view the Check Number Confirmation window.

No Authorization: Users cannot open the Check Number Confirmation window.

Electronic Reports

Full Authorization: Users can view and generate Electronic Reports
Read Only: Users can view Electronic Reports

No Authorization: Users cannot access Electronic Reports

Bank Reconciliation Report

Full Authorization: Users can run the Bank Reconciliation crystal report under

|} Banking Reports > External Reconciliation }

No Authorization: Users cannot run this report.

Payment Orders Report by
Business Partner

Full Authorization: Users can run the Payment Orders Report by Business Partner crys-
tal report under Banking Reports.

No Authorization: Users cannot run this report.

Payment Orders Report by
Payment Run

Full Authorization: Users can run the Payment Orders Report by Payment Run crystal re-
port under Banking Reports.

No Authorization: Users cannot run this report.
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12 Inventory Module Authorizations

The following modules and functions define the Inventory authorizations:

Field Name

Description

Inventory

e full Authorization: Users can access all the windows and perform all the actions speci-
fied in the Inventory module and make required changes or new settings.

® Read Only: Users can view the data defined in all the functions specified in the Inventory

module.

e No Authorization: Users cannot access any option specified in the Inventory module.

i Note

If you select the Read Only authorization for the entire Inventory module, the authoriza-
tions for its child items without the Read Only option are automatically set to No
Authorization.

Item Master Data

® Full Authorization: Users can open and work in the Item Master Data window, modify
and view data, and perform all the actions specified in this section.

® Read Only: Users can view the [tem Master Data window.

e No Authorization: Users cannot open the Item Master Data window.

General Tab ® Full Authorization: Users can view and edit the data on the General tab in the Item
Master Data window, unless they have no authorization for a specific field on the tab.
® Read Only: Users can view but cannot edit the data on the General tab in the Item
Master Data window.
® No Authorization: The General tab in the Item Master Data window is hidden.
Purchasing Tab e full Authorization: Users can view and edit the data on the Purchasing tab in the ltem
Master Data window, unless they have no authorization for a specific field on the tab.
® Read Only: Users can view but cannot edit the data on the Purchasing tab in the Item
Master Data window.
e No Authorization: The Purchasing tab in the [tem Master Data window is hidden.
Sales Tab ® Full Authorization: Users can view and edit the data on the Sales tab in the Item Master

Data window, unless they have no authorization for a specific field on the tab.

® Read Only: Users can view but cannot edit the data on the Sales tab in the ltem Master
Data window.

e No Authorization: The Sales tab in the Item Master Data window is hidden.
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Field Name Description

Inventory Tab ® full Authorization: Users can view and edit the data on the Inventory tab in the ltem
Master Data window, unless they have no authorization for a specific field on the tab.

e Read Only: Users can view but cannot edit the data on the Inventory tab in the ltem
Master Data window.

e No Authorization: The Inventory tab in the ltem Master Data window is hidden.

Planning Tab e full Authorization: Users can view and edit the data on the Planning tab in the Item
Master Data window, unless they have no authorization for a specific field on the tab.

® Read Only: Users can view but cannot edit the data on the Planning tab in the ltem
Master Data window.

e No Authorization: The Planning tab in the ltem Master Data window is hidden.

Production Tab e full Authorization: Users can view and edit the data on the Production tab in the Item
Master Data window, unless they have no authorization for a specific field on the tab.

® Read Only: Users can view but cannot edit the data on the Production tab in the Item
Master Data window.

e No Authorization: The Production tab in the Item Master Data window is hidden.

Properties Tab ® full Authorization: Users can view and edit the data on the Properties tab in the ltem
Master Data window, unless they have no authorization for a specific field on the tab.

® Read Only: Users can view but cannot edit the data on the Properties tab in the ltem
Master Data window.

e No Authorization: The Properties tab in the Item Master Data window is hidden.

Remarks Tab ® Full Authorization: Users can view and edit the data on the Remarks tab in the ltem
Master Data window, unless they have no authorization for a specific field on the tab.

® Read Only: Users can view but cannot edit the data on the Remarks tab in the Item
Master Data window.

® No Authorization: The Remarks tab in the ltem Master Data window is hidden.

Attachments Tab e Full Authorization: Users can view and edit the data on the Attachments tab in the Item
Master Data window, unless they have no authorization for a specific field on the tab.

e Read Only: Users can view but cannot edit the data on the Attachments tab in the Item
Master Data window.

e No Authorization: The Attachments tab in the Iltem Master Data window is hidden.
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Field Name

Description

Intrastat Settings Tab

Full Authorization: Users can view and edit the data on the Intrastat Settings tab in the
Item Master Data window, unless they have no authorization for a specific field on the
tab.

Read Only: Users can view but cannot edit the data on the Intrastat Settings tab in the
Item Master Data window.

No Authorization: The Intrastat Settings tab in the Item Master Data window is hidden.

i Note

The authorization for Intrastat Settings Tab will be updated to no authorization when no
authorization is selected for General Tab.

The authorization for General Tab will be updated to read-only when full or read-only au-

thorization is selected for Intrastat Settings Tab.

Localization Fields Tab

Full Authorization: Users can view and edit the data on the Localization Fields tab in the

Item Master Data window, unless they have no authorization for a specific field on the
tab.

Read Only: Users can view but cannot edit the data on the Localization Fields tab in the

Item Master Data window.

No Authorization: The Localization Fields tab in the Item Master Data window is hidden.

Active

to create documents that include this item.

Full Authorization: Users can select or deselect the Active checkbox (|} Item Master
Data > General } tab). When the checkbox is selected, three additional fields are dis-
played, letting you define the validity period and enter comments.

No Authorization: Users cannot set a validity period for an item.

Users can set a validity period for the item. When this validity period is over, it is not possible

Inactive

Full Authorization: Users can select or deselect the Inactive checkbox (|> [tem Master
Data » General 4 tab). When the checkbox is selected, three additional fields are dis-
played, letting you define the inactive period and enter comments.

No Authorization: Users cannot set an inactive period for an item.

Valuation Method

Full Authorization: When adding a new item or updating an existing one, users can

change the Valuation Method set for the item (|} Item Master Data > Inventory Data ]

tab).
Read Only: Users cannot change this definition.

No Authorization: Users cannot change this definition.

Remove Item Master Data

Full Authorization: Users can delete an item master data record (from the menu bar,

choose |} Data > Remove; ]or choose Remove from the context menu).

No Authorization: Users cannot delete an Item Master Data record.

How to Define Authorizations in SAP Business One 10.0

Inventory Module Authorizations

PUBLIC

91



Field Name Description

Bar Codes e Full Authorization: Users can define and enter one or more Bar-Codes into the [tem
Master Data.

® Read Only: Users can view Bar-Codes in the Item Master Data

® No Authorization: Users cannot view or modify Bar-Codes in the Item Master Data

Bin Locations e full Authorization: Users can access all the windows and perform all the actions speci-
fied in the Bin Locations submenu.
® Read Only: Users can view the data defined in all the functions specified in the Bin
Locations submenu.
® No Authorization: Users cannot access any option specified in the Bin Locations sub-

menu.

Bin Location Master Data ® Full Authorization: Users can access the Bin Location Master Data window and add new
master data or update the existing master data.

® Read Only: Users can view Bin Location Master Data only.

e No Authorization: Users cannot access Bin Location Master Data.

Activate and Deactivate Bin ® Full Authorization: Users can activate or deactivate a piece of bin location master data
Location by selecting or deselecting the Inactive checkbox in the Bin Location Master Data win-
dow.

e No Authorization: The Inactive checkbox is disabled.

Transaction Restrictions ® full Authorization: Users can modify the Transaction Restrictions setting in the Bin
Location Master Data window.

® No Authorization: Users cannot modify this setting.

Bin Location Management e full Authorization: Users can access the Bin Location Management window and gener-
ate, update and delete a range of bin locations.

® No Authorization: Users cannot access the Bin Location Management window.

Bin Location Code ® Full Authorization: Users can access the Bin Location Code Modification window and
Modification modify bin location codes.

® Read Only: Users cannot access the Bin Location Code Modification window.

o No Authorization: Users cannot access the Bin Location Code Modification window.
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Field Name

Description

Item Management

® full Authorization: Users can access all the windows, perform all the actions relevant to
the ltem Management submenu.

® Read Only: Users can view the data defined in all of the functions available under the
Item Management submenu.

e No Authorization: Users cannot access any option under the Item Management sub-
menu.

i Note

If you select Read Only authorization for the entire ltem Management menu, the authori-
zations for its child items without the Read Only option are automatically set to No
Authorization.

Item Serial Numbers

® Full Authorization: Users can open all the windows specified in the Serial Numbers sub-
menu, add new serial numbers, and update existing ones.

® No Authorization: Users cannot open these windows.

Serial Number Management

® full Authorization: Users can access the Serial Numbers Management window, view se-
rial numbers selected in documents, update data for specific serial numbers, or per-
form a sweeping update of several serial numbers.

® No Authorization: Users cannot open this window.

i Note

A user with no authorization for the Serial Numbers Management window cannot select
or define serial numbers in documents. For example, the user cannot right-click in the
Quantity field and choose Batch/Serial Numbers in stock release documents or open
the Define Serial Numbers window in stock receipt documents.

Serial Number Details

e full Authorization: Users can access the Serial Number Details window, view serial num-
bers selected in documents, update data for specific serial numbers, or perform a
sweeping update of several serial numbers.

e No Authorization: Users cannot open this window.

Batches

e full Authorization: Users can open all the windows specified in the Batches submenu,
add new serial number, and update existing ones.

® No Authorization: Users cannot open these windows.
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Field Name

Description

Batch Management

® full Authorization: Users can access the Batch Management window, view batch num-
bers selected in documents, update data for specific batch numbers or perform a
sweeping update of several batch numbers.

e No Authorization: Users cannot open this window.

A Caution

A user with no authorization for the Batch Management window cannot select or define
batch numbers in documents. For example, the user cannot right-click in the Quantity
field and select Batch/Serial Numbers in stock release documents or open the Define
Batches window in inventory receipt documents.

Batch Details

® full Authorization: Users can access the Batch Details window, view batch numbers se-
lected in documents, update data for specific batch numbers, or perform a sweeping
update of several batch numbers.

e No Authorization: Users cannot open this window.

Alternative Items

e Full Authorization: Users can access the Alternative ltems window, define new alterna-
tive items for a certain item or even delete alternative item definitions.
® Read Only: Users can view the Alternative [tems window.

® No Authorization: Users cannot open the Alternative ltems window.

Business Partner Catalog
Numbers

e full Authorization: Users can access the Business Partner Catalog Numbers window, de-
fine new business partner catalog number for items, and update or delete catalog num-
bers.

® Read Only: Users can view the Business Partner Catalog Numbers window.

e No Authorization: Users cannot open the Business Partner Catalog Numbers window.

Global Update to BP Catalog
Numbers

e Full Authorization: Users can access the Global Update to BP Catalog Numbers window
and replace catalog numbers for a selected range of business partners and/or items.

e No Authorization: Users cannot open this window.

Inventory Valuation Method

® full Authorization: Users can access the Inventory Valuation Method window and update
the costing method of items.

® Read Only: Users can view the Inventory Valuation Method window.

e No Authorization: Users cannot open the Inventory Valuation Method window.
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Field Name Description

Inventory Transactions ® full Authorization: Users can access all the windows and perform all the actions availa-
ble under the Inventory Transactions submenu.
® Read Only: Users can view the data defined under all the functions in the Inventory
Transactions submenu.
e No Authorization: Users cannot access any option in the Inventory Transactions sub-
menu.

i Note

If Read Only authorization is selected for the entire Inventory Transactions submenu,
the authorizations for its child items without the Read Only option are automatically set
to No Authorization

Goods Receipt ® Full Authorization: Users can open the Goods Receipt window, add new documents and
modify existing ones.

® Read Only: Users can view Goods Receipt documents.

e No Authorization: Users cannot open the Goods Receipt window.

Goods Issue e full Authorization: Users can open the Goods Issue window, add new documents, and
modify existing ones.

® Read Only: Users can view Goods Issue documents.

e No Authorization: Users cannot open the Goods Issue window.

Inventory Transfer Request ® full Authorization: Users can open the Inventory Transfer Request window, add new
documents, and modify existing ones.

® Read Only: Users can view Inventory Transfer Request documents.

® No Authorization: Users cannot open this window.

Inventory Transfer ® full Authorization: Users can open the Inventory Transfer window, add new documents,
and modify existing ones.
® Read Only: Users can view Inventory Transfer documents.

e No Authorization: Users cannot open the Inventory Transfer window.

Inventory Counting ® full Authorization: Users can access all the windows and perform all the actions availa-
Transactions ble under the Inventory Counting Transactions submenu.
® Read Only: Users can access and view the windows available under the Inventory
Counting Transactions submenu.
e No Authorization: Users cannot access any option under the Inventory Counting
Transactions submenu.

i Note

If you select the Read Only authorization for the Inventory Counting Transactions sub-
menu, the authorizations for its child items without the Read Only option are automati-
cally set to No Authorization.
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Field Name

Description

Inventory Counting

Full Authorization: Users can open the Inventory Counting window, add new documents
and modify existing ones.

Read Only: Users can view the Inventory Counting window.

No Authorization: Users cannot open the Inventory Counting window.

Special Inventory Counting
Authorizations

Full Authorization: Users have full authorization for all the child options under the
Special Inventory Counting Authorizations submenu.

No Authorization: Users have no authorization for any of the child options under the
Special Inventory Counting Authorizations submenu.

Modify Inventory Counting

Full Authorization: Users can open an existing Inventory Counting document and modify
it.

No Authorization: Users can view inventory counting documents but cannot modify
them when they have authorization for Inventory Counting.

Freeze Items

Full Authorization: Users can freeze an item or cancel this action by selecting or dese-
lecting the Freeze checkbox in the table row of the Inventory Counting window.

When this checkbox is selected, you can prevent any transaction (except inventory
posting) that affects the in-warehouse quantity of the item in the selected warehouse
and bin.

No Authorization: you cannot select or deselect this checkbox.

Inventory Posting

Full Authorization: Users can open the Inventory Posting window, add new documents
and modify the existing ones.

Read Only: Users can view the Inventory Posting window only.

No Authorization: Users cannot open this window.

Inventory Opening Balance

Full Authorization: Users can open the Inventory Opening Balance window, add new
documents and modify the existing ones.

Read Only: Users can view the Inventory Opening Balance window.

No Authorization: Users cannot open the Inventory Opening Balance window.

Cycle Count
Recommendations

Full Authorization: Users can open the Cycle Count Recommendations window and per-
form various actions.

Read Only: Users can view the Cycle Count Recommendations window.

No Authorization: Users cannot open this window.

Inventory Revaluation

Full Authorization: Users can open the Inventory Revaluation window, add new docu-
ments and view the existing ones.

Read Only: Users can view Inventory Revaluation documents.

No Authorization: Users cannot open this window.

96 PUBLIC

How to Define Authorizations in SAP Business One 10.0
Inventory Module Authorizations



Field Name Description

Price Lists e full Authorization: Users can access all the windows, perform all the actions available
under the Price Lists submenu.

® Read Only: Users can access and view windows available under the Price Lists sub-
menu.

e No Authorization: Users cannot access any option under the Price List submenu.

Price Lists ® full Authorization: Users can access all the windows and perform all the actions availa-
ble under the Price Lists submenu.

® Read Only: Users can access and view windows available under the Price Lists sub-
menu.

e No Authorization: Users cannot access any option under the Price Lists submenu.

Price List: Group No. 1-10 Users can access price lists related to a certain group (| Inventory ¥ Price Lists ¥ Price

Lists > Group }).

® full Authorization: Users can access all the price lists related to the group.
® Read Only: Users can view the price lists related to the group.

® No Authorization: Users cannot access any price list related to the group.

i Note

A user with no authorization for a certain price list group is not able to view its prices in
the Item Master Data window. The Price field displays asterisks (****) for restricted
price list groups. In addition, the price list is excluded from the price list drop-down list
of any other relevant windows.

Last Evaluated Price e Full Authorization: Users can view the Last Evaluated Price list.

e No Authorization: Users cannot view data in this price list.

i Note

A user with no authorization for the Last Evaluated Price list cannot view its prices in the
Item Master Data window. The Price field displays asterisks (****) for this price list.

Last Purchase Price e full Authorization: Users can view the Last Purchase Price list.

® No Authorization: Users cannot view data in this price list.

i Note

A user with no authorization for the Last Purchase Price list is not able to view its prices
in any relevant windows, for example, the Item Master Data window. The Price field in
the Item Master Data window displays asterisks (¥***) for this price list.

Item Cost ® full Authorization: Users can view [tem Cost in relevant windows, for example, the Item
Master Data window, marketing documents, Batch Details window and Serial Number
Details window (when the item is managed by the batch/serial valuation method).

e No Authorization: Users cannot view [tem Cost.
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Field Name

Description

Period and Volume Discounts

Full Authorization: Users can access the Hierarchies and Expansions window and define
date-dependent and quantity-dependent hierarchies and expansions for selected price
lists.

Read Only: Users can view the Hierarchies and Expansions window.

No Authorization: Users cannot open the Hierarchies and Expansions window.

Special Prices

Full Authorization: Users can access all the windows under the Special Prices submenu,
add new data, modify existing data, and perform various actions.
Read Only: Users can view the different windows under the Special Prices submenu.

No Authorization: Users cannot access any window under the Special Prices submenu.

Special Prices for Business
Partners

Full Authorization: Users can access the Special Prices for Business Partners window,
define special prices for business partners, and modify existing data.

Read Only: Users can view the Special Prices for Business Partners window.

No Authorization: Users cannot open the Special Prices for Business Partners window.

Copy Special Prices to
Selection Criteria

Full Authorization: Users can access the Copy Special Prices to Selection Criteria win-
dow and copy special prices to a range of business partners and/or items.

No Authorization: Users cannot open this window.

Update Special Prices
Globally

Full Authorization: Users can access the Update Special Prices Globally window and per-
form a global update of special prices by changing the discount %, price, or linked price
list.

No Authorization: Users cannot open this window.

Discount Groups

Full Authorization: Users can access the Discount Groups window and define special pri-
ces according to discount groups.

Read Only: Users can view the Discount Groups window.

No Authorization: Users cannot open the Discount Groups window.

Update Parent Item Prices
Globally

Full Authorization: Users can access the Update Parent Item Prices Globally window and
update prices for the parent and child items comprising bills of materials.

Read Only: Users can view the Update Parent Iltem Prices Globally window.

No Authorization: Users cannot open this window.

Prices Update Wizard

Full Authorization: Users can access the Prices Update Wizard window and update pri-
ces globally.

No Authorization: Users cannot open this window.

98 PUBLIC

How to Define Authorizations in SAP Business One 10.0
Inventory Module Authorizations



Field Name Description

Execute Prices Update ® full Authorization: Users can execute the price updates with the Prices Update Wizard
window.

e No Authorization: Users cannot execute any price update with the Prices Update Wizard

window.

i Note

When users have full authorization for Prices Update Wizard and no authorization for
Execute Prices Update, theycan only view the prices update simulation.

Pick and Pack ® full Authorization: Users can access the Pick and Pack Manager and the Pick List win-
dows.

® No Authorization: Users cannot open these windows.

Pick Pack and Production ® Full Authorization: Users can access the Pick Pack and Production Manager window,
Manager pick and release sales orders, and pack items for delivery.

e No Authorization: Users cannot open this window.

Pick List ® full Authorization: Users can access the Pick List window, pick items, and pack them for

delivery.
® Read Only: Users can view the Pick List window.

e No Authorization: Users cannot open the Pick List window.

i Note

In addition to full authorization for Pick List, authorizations for the documents in the
Create drop-down list in the Pick List window are also required if you want to create
such documents from a pick list.

Inventory Reports Select Full Authorization or No Authorization for all windows and actions available under the

Inventory Reports submenu.

Items List ® Full Authorization: Users can access the [tems List report.

® No Authorization: Users cannot access the Items List report.

Last Prices Report ® Full Authorization: Users can access the Last Prices Report.

o No Authorization: Users cannot access the Last Prices Report.

Inactive Items ® Full Authorization: Users can access the Inactive ltems report.

e No Authorization: Users cannot access the Inactive Items report.
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Field Name

Description

Inventory Posting List

Full Authorization: Users can access the Inventory Posting List.

No Authorization: Users cannot access the Inventory Posting List.

i Note

In SAP Business One 10.0 FP 2011 or lower, users with full authorization for Inventory
Posting List and no authorization for Price List O1, can view the amount in the Price After
Disc. field of all documents except A/P invoices in the Inventory Posting List.

As of SAP Business One 10.0 FP 2102 or higher, you can set the authorization to view
the amount in the Price After Disc. field of purchasing, sales, and inventory documents
in the Inventory Posting List through their respective authorizations:

® View Price in Purchasing Documents
e View Price in Sales Documents

e View Price in Inventory Documents

Purchasing Documents

Full Authorization: In the Inventory Posting List, users can view the amount in the Price
After Disc. field of purchasing documents.

No Authorization: In the Inventory Posting List, the Price After Disc. field of purchasing
documents displays asterisks (¥**).

View Price in Sales
Documents

Full Authorization: In the Inventory Posting List, users can view the amount in the Price
After Disc. field of sales documents.

No Authorization: In the Inventory Posting List, the Price After Disc. field of sales docu-
ments displays asterisks (¥**).

View Price in Inventory

Full Authorization: In the Inventory Posting List, users can view the amount in the Price

Documents After Disc. field of inventory documents.
e No Authorization: In the Inventory Posting List, the Price After Disc. field of inventory
documents displays asterisks (¥**).
Inventory Status ® Full Authorization: Users can access the Inventory Status report.

No Authorization: Users cannot access the Inventory Status report.

Inventory in Warehouse
Report

Full Authorization: Users can access the Inventory in Warehouse Report.

No Authorization: Users cannot access the Inventory in Warehouse Report.

Inventory Audit Report

Full Authorization: Users can access the Inventory Audit Report.

i Note

Users with no authorization for ltem Cost can view the cost in this report.

No Authorization: Users cannot access the Inventory Audit Report.
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Field Name

Description

Inventory Valuation
Simulation Report

Full Authorization: Users can access the Inventory Valuation Simulation Report.

No Authorization: Users cannot access the Inventory Valuation Simulation Report.

i Note

This report is available when you manage a perpetual inventory system.

Inventory Valuation Report

Full Authorization: Users can access the Inventory Valuation Report.

No Authorization: Users cannot access the Inventory Valuation Report.

i Note

This report is available when you manage a non-perpetual inventory system.

Batch Number Transactions
Report

Full Authorization: Users can access the Batch Number Transactions Report.

No Authorization: Users cannot access the Batch Number Transactions Report.

Serial Number Transactions
Report

Full Authorization: Users can access the Serial Number Transactions Report..

No Authorization: Users cannot access the Serial Number Transactions Report.

Bin Location List

Full Authorization: Users can access the Bin Location List report.

No Authorization: Users cannot access the Bin Location List report.

i Note

This report is available when the Enable Bin Locations checkbox is selected for at least
one warehouse.

Bin Location Content List

Full Authorization: Users can access the Bin Location Content List report.

No Authorization: Users cannot access the Bin Location Content List report.

i Note

This report is available when the Enable Bin Locations checkbox is selected for at least
one warehouse.

Price Report

Full Authorization: Users can access the Price Report.

No Authorization: Users cannot access the Price Report.

Discount Group Report

Full Authorization: Users can access the Discount Group Report.

No Authorization: Users cannot access the Discount Group Report.

Inventory Counting
Transactions Report

Full Authorization: Users can access the Inventory Counting Transactions Report.

No Authorization: Users cannot access the Inventory Counting Transactions Report.

Inventory Valuation Method
Report

Full Authorization: Users can access the Inventory Valuation Method Report.

No Authorization: Users cannot access the Inventory Valuation Method Report.
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Field Name Description

Inventory Turnover Analysis e Full Authorization: Users can access the Inventory Turnover Analysis crystal report.

e No Authorization: Users cannot access the Inventory Turnover Analysis crystal report.
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13 Resources Module Authorizations

The following modules and functions define the Resources authorizations:

Field Name

Description

Resources

e full Authorization:Users can access all the windows and perform all the actions availa-
ble under the Resources submenu.

® Read Only: Users can access and view windows available under the Resources sub-
menu.

e No Authorization: Users cannot access any option available under the Resources sub-
menu.

i Note

If you select the Read Only authorization for the Resources submenu, the authorizations
for its child items without the Read Only option are automatically set to No
Authorization.

Resource Master Data

e full Authorization: Users can access the Resource Master Data window, add new master
data and modify the existing master data.

e Read Only: Users can view the Resource Master Data window only.

e No Authorization: Users cannot access this window.

Resource Capacity

® Full Authorization: Users can access the Resource Capacity window and define resour-
ces capacity.
® Read Only: Users can view the Resource Capacity window only.

e No Authorization: Users cannot access this window.

Set Daily Internal Capacities

e full Authorization: Users can access this window and set daily internal capacities.

e No Authorization: Users cannot access this window.
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14 Production Module Authorizations

The following modules and functions define the Production authorizations:

Field Name

Description

Production

e full Authorization: Users can enter all the windows located under the Production mod-
ule and make new settings and modifications.

® Read Only: Users can view the data in all the windows located under the Production
module.

® No Authorization: Users cannot access any window located under the Production mod-
ule.

i Note

If you select Read Only authorization for the entire Production module, the authoriza-
tions for its child items without the Read Only option are automatically set to No
Authorization.

Bill of Materials

e full Authorization: Users can access the Bill of Materials window, define new bills of ma-
terials, or modify existing ones.

® Read Only: Users can view the Bill of Materials window.

e No Authorization: Users cannot open the Bill of Materials window.

Production Order

e full Authorization: Users can access the Production Order window, plan new production
orders, modify existing ones, release orders for production, and close production or-
ders at the end of the production process.

® Read Only: Users can view the Production Order window.

e No Authorization: Users cannot open the Production Order window.

i Note

To enable the Report Completion option in the context menu of a production order, full
authorization for Receipt from Production and for Issue for Production (when the issue
method is Backflush) are required.

Receipt from Production

e full Authorization: Users can access the Receipt from Production window and release or
receive quantities.

® Read Only: Users can view the Receipt from Production window.

e No Authorization: Users cannot open the Receipt from Production window.

Issue for Production

e full Authorization: Users can access the Issue for Production window and release or re-
ceive quantities.

® Read Only: Users can view the Issue for Production window.

® No Authorization: Users cannot open the Issue for Production window.
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Field Name Description

Bill of Materials - Component ~®  Full Authorization: Users can access the Bill of Materials - Component Management win-
Management dow and apply batch updates to BOMs.

® No Authorization: Users cannot access this window.

Production Std Cost ® full Authorization: Users can access all the windows available under the Production Std
Management Cost Management submenu.
® No Authorization: Users cannot access any window under the Production Std Cost
Management submenu.

Production Std Cost Rollup ® full Authorization: Users can access the Production Std Cost Rollup window and update
a parent item's production standard cost with the sum of total production standard
costs of its BOM components.

i Note

The checkbox Include in Production Std Cost Rollup on the |} Item Master Data >

Production Data 4 tab must be selected for the parent item.

e No Authorization: Users cannot access this window.

Production Std Cost Update ® full Authorization: Users can access the Production Std Cost Update window and over-
write the production standard cost value with the current item cost value.

i Note

The checkbox Include in Production Std Cost Rollup on the |[# ltem Master Data »

Production Data } tab must be selected for the item.

This functionality is available when you manage a perpetual inventory system.

® No Authorization: Users cannot access this window.

Production Cost e Full Authorization: Users can run the Production Cost Recalculation Wizard.

Recalculation Wizard e No Authorization: Users cannot access this wizard.

This functionality is available when you manage items by the serial or batch valuation

method.
Execute Production Cost e full Authorization: Users can execute the Production Cost Recalculation Wizard.
Recalculation Run e No Authorization: When users have full authorization for Production Cost Recalculation

Wizard and no authorization for Execute Production Cost Recalculation Run, they can
only run a simulation.

Production Reports ® Full Authorization: Users can access all windows available under the Production Reports
submenu.
® No Authorization: Users cannot access any window under the Production Reports sub-
menu.
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Field Name Description

Electronic Reports ® Full Authorization: Users can view and generate Electronic Reports
® Read Only: Users can view Electronic Reports

® No Authorization: Users cannot access Electronic Reports

Bill of Materials Report ® Full Authorization: Users can view and generate Bill of Materials Reports.

e No Authorization: Users cannot open the Bill of Materials Reports.
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15 MRP Module Authorizations

The following modules and functions define the MRP authorizations:

Field Name Description

MRP e full Authorization: Users can enter all the windows specified in the MRP module.
® Read Only: Users can view only the Forecasts window.

e No Authorization: Users cannot access any window specified in the MRP module.

i Note

If you select Read Only authorization for the entire MRP module, the authorizations for
its child items without the Read Only option are automatically set to No Authorization.

Forecasts e full Authorization: Users can access the Forecasts window, define new forecasts, or
modify existing ones.
® Read Only: Users can view the Forecasts window.

e No Authorization: Users cannot open the Forecasts window.

MRP Wizard e full Authorization: Users can access the MRP Wizard window and run MRP calculation
of recommendations.

e No Authorization: Users cannot access the wizard.

Order Recommendation ® Full Authorization: Users can access the Order Recommendation Report window and
create purchase requests, purchase quotations, purchase orders, production orders
and stock transfer requests.

i Note

Full authorization for the corresponding documents is required.

e No Authorization: Users cannot open this window.

MRP Reports ® full Authorization: Users can access MRP Reports

e No Authorization: Users cannot access MRP Reports

Electronic Reports e full Authorization: Users can view and modify Electronic Reports
® Read Only: Users can view Electronic Reports

e No Authorization: Users cannot access Electronic Reports
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16 Service Module Authorizations

The following modules and functions define the Service authorizations:

Field Name

Description

Service

Full Authorization: Users can enter all the windows located under the Service module
and perform the various actions available in this module.

Read Only: Users can view the data in all the windows located under the Service mod-
ule.

No Authorization: Users cannot access any window located under the Service module.

i Note

If you select the Read Only authorization for the entire Service module, the authoriza-

tions for its child items without the Read Only option are automatically set to No
Authorization.

Service Call

Full Authorization: Users can open the Service Call window, record new service calls,
and update existing ones.

Read Only: Users can view the Service Call window.

No Authorization: Users cannot open the Service Call window.

Special Service Call

Full Authorization: Users can perform all the actions available under the Special Service

Authorizations Call Authorizations submenu.
No Authorization: Users cannot perform any of these actions.
Change Status Full Authorization: Users can change the status of a service call by clicking the Call

Status field in a service call and selecting a different status.

No Authorization: Users cannot change the status of a service call.

Define Statuses

Full Authorization: Users can define a new status for a service call by clicking the Call
Status field in a service call and selecting the option Define New to open the Service Call
Statuses - Setup window.

No Authorization: Users cannot change the status of a service call.

Reopen

Full Authorization: Users can reopen a service call and change its status from Closed to
Open by clicking the Call Status field in a closed service call and selecting Open.

No Authorization: Users cannot reopen a service call.

Edit Created On/Closed On

Full Authorization:Users can edit the Created On field when they create a new service
call and can edit the Closed On field when they change the service call status to Closed
in the Service Call window.

No Authorization: Users cannot edit the fields Created On or Closed On in the Service
Call window.
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Field Name

Description

Allow Service Without
Contract

e Full Authorization: Users can record a service call for customers without a valid service
contract. The following system message is displayed: Warning: No valid
contracts exist for the customer. Userscan confirm the system mes-
sage by choosing the OK button and recording the service call.

e No Authorization: Users cannot confirm the system message or process service calls
for customers with no valid service contracts.

Allow Service Beyond
Coverage Time

e full Authorization: Users can record a service call with a Created On date which exceeds
the coverage time defined in the service contract. The following system message ap-
pears:Warning: You cannot create a service call outside
normal working hour or on public holidays. Confirm the system
message by choosing OK, and then process the service call.

e No Authorization: Users cannot confirm the system message or process service calls
that deviate from the coverage time defined in the service contract.

Allow Service Beyond Credit
Limit

® full Authorization: Users can record a service call for a customer that deviates from his
or her credit limit (defined by choosing |} Business Partners > Business Partner Master

Data > Payment Terms ] tab.) The following system message appears: Customer
has passed credit limit.Confirm the system message by choosing the OK
button, and then process the service call.

® No Authorization: Users cannot confirm this message or process service calls for cus-
tomers who deviate from their credit limit.

i Note

System messages regarding deviations from the credit limit appear only if the Credit
Limit checkbox is selected (|} Administration > System Initialization > General Settings

> Sales > Customer Activity Restrictions }).

Equipment Card

® full Authorization: Users can access the Equipment Card window, create new customer
equipment cards, and modify existing ones.

® Read Only: Users can view the Equipment Card window.

e No Authorization: Users cannot open the Equipment Card window.

i Note

When users have read only or no authorization for Equipment Card but the Auto. Create

Equipment Card checkbox on thellr General Settings * Inventory dtab is selected, the
automatic creation of an equipment card which follows the creation of a delivery or in-
voice is enabled.

Service Contract

e Full Authorization: Users can access the Service Contract window, define new service
contracts, and modify existing ones.

® Read Only: Users can view the Service Contract window.

® No Authorization: Users cannot open the Service Contract window.
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Field Name Description

Change Status e Full Authorization: Users can change the status of a service contract by clicking the Sta-

tus field (|) Service Contract > General 1 tab) and selecting a status from the drop-
down list.

e No Authorization: Users cannot change the status of a service contract.

Solutions Knowledge Base ® full Authorization: Users can access the Solutions Knowledge Base window, add new
solutions, and modify existing ones.
® Read Only: Users can view the Solutions Knowledge Base window.

e No Authorization: Users cannot open the Solutions Knowledge Base window.

Special Solution e full Authorization: Users can change the status of a knowledge base solution by select-
Authorizations ing a status from the Status field in the Solutions Knowledge Base window.
e No Authorization: Users cannot change the status of a knowledge base solution.
Change Status
Service Reports ® full Authorization: Users can access all the windows and perform various actions availa-
ble under the Service Reports submenu.
® Read Only: Users can view the data in all the windows available under the Service
Reports submenu.
e No Authorization: Users cannot access any window under the Service Reports sub-
menu.
i Note
If you select the Read Only authorization for the Service Reports submenu, the authori-
zations for its child items without the Read Only option are automatically set to No
Authorization.
Service Calls e full Authorization: Users can access the Service Calls report.
e No Authorization: Users cannot access the Service Calls report.
Service Calls by Queue - ® full Authorization: Users can access the Service Calls by Queue report.
Selection Criteria ® No Authorization: Users cannot access the Service Calls by Queue report.

Response Time by Assigned ® Full Authorization: Users can access the Response Time by Assigned to report.

to - Selection Criteria e No Authorization: Users cannot access the Response Time by Assigned to report.

Average Closure Time ® full Authorization: Users can access the Average Closure Time report.

e No Authorization: Users cannot access the Average Closure Time report.

Service Contracts ® Full Authorization: Users can access the Service Contracts report.

e No Authorization: Users cannot access the Service Contracts report.

Equipment Card Report e full Authorization: Users can access the Equipment Card Report.

e No Authorization: Users cannot access the Equipment Card Report.
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Field Name Description

Service Monitor ® Full Authorization: Users can access the Service Monitor report.

e No Authorization: Users cannot access the Service Monitor report.
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17 Human Resources Module Authorizations

The following modules and functions define the Human Resources authorizations:

Field Name Description
Human Resources e full Authorization: Users can open all windows and reports in the Human Resources
module.

® Read Only: Users can view the data in all the windows in the Human Resources module.

e No Authorization: Users cannot access any window in the Human Resources module.

i Note

If you select Read Only authorization for the entire Human Resource module, the au-
thorizations for its child items without the Read Only option are automatically set to No
Authorization.

Employee Master Data ® Full Authorization: Users can access the Employee Master Data window, create new
master data for company employees, and modify existing ones.

® Read Only: Users can view the Employee Master Data window.

e No Authorization: Users cannot open the Employee Master Data window.

Time Sheet e full Authorization: Users can access the Time Sheet window, create new time sheet,
and modify existing ones.

® Read Only: Users can view the Time Sheet window.

® No Authorization: Users cannot open the Time Sheet window.

Human Resources Reports Users can r grant Full Authorization or No Authorization for the Human Resources Reports.

Employee List e full Authorization: Users can access the Employee List window.

e No Authorization: Users cannot access the Employee List window.

Absence Report ® full Authorization: Users can access the Absence Report.

® No Authorization: Users cannot access the Absence Report.

Phone Book ® full Authorization: Users can access the Phone Book.

e No Authorization: Users cannot access the Phone Book.
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18 Project Management Module
Authorizations

The following modules and functions define the Project Management authorizations:

Field Name Description

Project Management b

Full Authorization: Users can enter all the windows and reports specified in the Project
Management module.

Read Only: Users can view the data in all the windows specified in the Project
Management module.

No Authorization: Users cannot access any window specified in the Project
Management module

i Note

If you select Read Only authorization for the entire Project Management module, the au-
thorizations for its child items without the Read Only option are automatically set to No
Authorization.

The Project Management menu is available only when the Enable Project Management
checkbox on the |} Administration > System Initialization > Company Details > Basic

Initialization 1 tab is selected.

Project ® Full Authorization: Users can access the Project window, create new project, and modify
existing ones.
® Read Only: Users can view the Project window.
e No Authorization: Users cannot open the Project window.
Project Reports You can grant Full Authorization or No Authorization for the Project Management Reports.
Stage Analysis - Selection e full Authorization: Users can access the Stage Analysis report.
Criteria ® No Authorization: Users cannot access the Stage Analysis report.
Open Issues - Selection ® full Authorization: Users can access the Open Issues report.
Criteria ® No Authorization: Users cannot access the Open Issues report.

Resources - Selection Criteria  ®

Full Authorization: Users can access the Resources report.

No Authorization: Users cannot access the Resources report.

Time Sheet - Selection °
Criteria

Full Authorization: Users can access the Time Sheet report.

No Authorization: Users cannot access the Time Sheet report.
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19 Reports Module Authorizations

The following modules and functions define the Reports authorizations:

Field Name

Description

Reports

Full Authorization: Users can enter all the windows and reports specified in the Reports
module.

Read Only: Users can view the data in all the windows specified in the Reports module.

No Authorization: Users cannot access any window specified in the Reports module

i Note

If you select Read Only authorization for the entire Reports module, the authorizations
for its child items without the Read Only option are automatically set to No
Authorization.

Sales and Purchasing

Full Authorization: Users can access all the sales and purchasing reports available un-
der the Sales and Purchasing submenu.

No Authorization: Users cannot access these reports.

Open Items List

Full Authorization: Users can access all the windows and reports available under the
Open Items List menu entry.

No Authorization: access cannot access any window under this menu entry.

i Note

You can access Open Items List by choosing one of the following from the Main Menu of
SAP Business One: |} Sales - A/R > Sales Reports, Purchasing - A/P } Purchasing

Reports, Inventory > Inventory Reports ] orl'» Reports > Sales and Purchasing }

Sales Quotations

Full Authorization: Users can access open Sales Quotations from the Open Documents
drop-down list in the Open Items List window.

No Authorization: Users cannot access open Sales Quotations from the Open
Documents drop-down list in the Open Items List window.

Sales Orders

Full Authorization: Users can access open Sales Orders from the Open Documents drop-
down list in the Open Items List window.

No Authorization: Users cannot access open Sales Orders from the Open Documents
drop-down list in the Open Items List window.

Deliveries

Full Authorization: Users can access open Deliveries from the Open Documents drop-
down list in the Open Items List window.

No Authorization: Users cannot access open Deliveries from the Open Documents drop-
down list in the Open Items List window.
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Field Name Description

Return Requests ® full Authorization: Users can access open Return Requests from the Open Documents
drop-down list in the Open Items List window.
e No Authorization: Users cannot access open Return Requests from the Open
Documents drop-down list in the Open Items List window.

Returns ® full Authorization: Users can access open Returns from the Open Documents drop-
down list in the Open Items List window.
e No Authorization: Users cannot access open Returns from the Open Documents drop-
down list in the Open Items List window.

A/R Down Payments - Unpaid ® Full Authorization: Users can access unpaid A/R Down Payments from the Open
Documents drop-down list in the Open Items List window.
e No Authorization: Users cannot access unpaid A/R Down Payments from the Open
Documents drop-down list in the Open Items List window.

A/R Down Payments - Not ® Full Authorization: Users can access A/R Down Payments that are not yet fully applied
Yet Fully Applied from the Open Documents dropdown list in the Open Items List window.
e No Authorization: Users cannot access A/R Down Payments that are not yet fully ap-
plied from the Open Documents dropdown list in the Open Items List window.

A/R Invoices ® full Authorization: Users can access open A/R Invoices from the Open Documents
drop-down list in the Open Items List window.
e No Authorization: Users cannot access open A/R Invoices from the Open Documents
drop-down list in the Open Items List window.

A/R Credit Memos ® Full Authorization: Users can access open A/R Credit Memos from the Open Documents
drop-down list in the Open Items List window.
e No Authorization: Users cannot access open A/R Credit Memos from the Open
Documents drop-down list in the Open Items List window.

A/R Reserve Invoices - ® Full Authorization: Users can access unpaid A/R Reserve Invoices from the Open
Unpaid Documents drop-down list in the Open Items List window.
e No Authorization: Users cannot access unpaid A/R Reserve Invoices from the Open
Documents drop-down list in the Open Items List window.

A/R Reserve Invoices - Not ® Full Authorization: Users can access A/R Reserve Invoices that are not yet fully deliv-
Yet Delivered eredfrom the Open Documents drop-down list in the Open Items List window.
e No Authorization: Users cannot access A/R Reserve Invoices that are not yet fully deliv-
eredfrom the Open Documents drop-down list in the Open Items List window.

Purchase Quotations ® Full Authorization: Users can access open Purchase Quotations from the Open
Documents drop-down list in the Open Items List window.
e No Authorization: Users cannot access open Purchase Quotations from the Open
Documents drop-down list in the Open Items List window.
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Field Name

Description

Purchase Requests

Full Authorization: Users can access open Purchase Requests from the Open
Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access open Purchase Requests from the Open
Documents drop-down list in the Open Items List window.

Purchase Orders

Full Authorization: Users can access open Purchase Orders from the Open Documents
drop-down list in the Open Items List window.

No Authorization: Users cannot access open Purchase Orders from the Open
Documents drop-down list in the Open Items List window.

Goods Receipt POs

Full Authorization: Users can access open Goods Receipt POs from the Open
Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access open Goods Receipt POs from the Open
Documents drop-down list in the Open Items List window.

Goods Return Requests

Full Authorization: Users can access open Goods Return Requests from the Open
Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access open Goods Return Requests from the Open
Documents drop-down list in the Open Items List window.

Goods Return

Full Authorization: Users can access open Goods Return from the Open Documents
drop-down list in the Open Items List window.

No Authorization: Users cannot access open Goods Return from the Open Documents
drop-down list in the Open Items List window.

A/P Down Payments - Unpaid

Full Authorization: Users can access unpaid A/P Down Payments from the Open
Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access unpaid A/P Down Payments from the Open
Documents drop-down list in the Open Items List window.

A/P Down Payments - Not Yet
Fully Applied

Full Authorization: Users can access A/P Down Payments that are not yet fully applied
from the Open Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access A/P Down Payments that are not yet fully ap-
plied from the Open Documents drop-down list in the Open Items List window.

A/P Invoices

Full Authorization: Users can access open A/P Invoices from the Open Documents drop-
down list in the Open Items List window.

No Authorization: Users cannot access open A/P Invoices from the Open Documents
drop-down list in the Open Items List window.

A/P Credit Memos

Full Authorization: Users can access open A/P Credit Memos from the Open Documents
drop-down list in the Open Items List window.

No Authorization: Users cannot access open A/P Credit Memos from the Open
Documents drop-down list in the Open Items List window.
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Field Name

Description

A/P Reserve Invoices -
Unpaid

Full Authorization: Users can access unpaid A/P Reserve Invoices from the Open
Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access unpaid A/P Reserve Invoices from the Open
Documents drop-down list in the Open Items List window.

A/P Reserve Invoices - Not
Yet Delivered

Full Authorization: Users can access A/P Reserve Invoices that are not yet fully deliv-
ered from the Open Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access A/P Reserve Invoices that are not yet fully deliv-
ered from the Open Documents drop-down list in the Open Items List window.

Inventory Transfer Requests

Full Authorization: Users can access open Inventory Transfer Requests from the Open
Documents drop-down list in the Open Items List window.

No Authorization: Users cannot access open Inventory Transfer Requests from the Open
Documents drop-down list in the Open Items List window.

Production Orders

Full Authorization: Users can access open Production Orders from the Open Documents
dropdown list in the Open Items List window.

No Authorization: Users cannot access open Production Orders from the Open
Documents dropdown list in the Open Items List window.

Missing Items

Full Authorization: Users can access Missing Items from the Open Documents drop-
down list in the Open Items List window.

No Authorization: Users cannot access Missing Items from the Open Documents drop-
down list in the Open Items List window.

Query Generator

Full Authorization: Users can open the Query Generator window, create new queries,
create and edit query categories, and view all the user—defined queries and system
queries.

Read Only: Users can open the Query Generator window but cannot create, edit or view
queries.

No Authorization: Users cannot access the Query Generator window and view queries.

New Queries

Full Authorization: Users can open the Query Generator or the Query Wizard window to
create new queries.

No Authorization: Users cannot open the Query Generator or the Query Wizard window.

Create/Edit Categories

Full Authorization: Users can open the Create/Edit Categories window (|} Query
Manager > Manage Categories }), create new categories for your queries, or edit exist-
ing ones.

No Authorization: Users cannot open the Create/Edit Categories window.
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Field Name

Description

Saved Queries: Group (No. 1-
20)

Users can run queries related to each of the 20 authorization groups available in SAP

Business One. Each query category can be linked to up to 20 authorization groups

(|} Query Manager > Manage Categories > Authorization Groups }). When linking query

categories to different authorization groups, it is possible to restrict certain users from run-

ning queries in the linked categories.

Full Authorization: Users can run queries related to categories linked to this authoriza-
tion group. For example, Full Authorization for Saved Queries: Group No. 1 lets you run
queries related to query categories linked to authorization group number 1.

Read Only: Users can view queries related to this authorization group but cannot save
queries in categories linked to this group.

No Authorization: Users cannot view queries linked to this group, nor save queries in
categories linked to this authorization group.

Execute Non-select SOL
Statement

Full Authorization: Users can generate Non-select SQL Statements.

No Authorization: Users cannot generate Non-select SQL Statements.

i Note

Make sure you have authorizations for query tools and for Modify SQL Statement.

Modify SQL Statement

Full Authorization: Users can edit the SQL statement in the Display Query Structure field
in the Query Generator window by clicking the pencil icon.

No Authorization: Users cannot edit the SQL statement in a query, but can view the text
in the Query Generator window.

Query Wizard

Full Authorization: Users can open the Query Wizard window and create new queries.

No Authorization: Users cannot use this wizard.

i Note

A user with no authorization for the New Queries field cannot open the Query Wizard.

Query Manager

Full Authorization: Users can open the Query Manager window, view, schedule, create a
report and remove a query.

Read Only: Users can open the Query Manager window, schedule and create a report
from a query. Users cannot view the query or remove it.

No Authorization: Users cannot open the Query Manager window.

Report Scheduling

Full Authorization: Users can access all forms specified in the Report Scheduling sec-
tion.

Read Only: Users can view the data in all forms specified in the Report Scheduling sec-
tion.

No Authorization: Users cannot access any form specified in the Report Scheduling sec-
tion.
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Field Name Description

Scheduled Report Overview o Fyl| Authorization: Users can open the Scheduled Report Overview window (|l Tool ¥
Scheduled Report Overview }) to view all the scheduled reports and those already exe-
cuted.

e Read Only: Users can view the Scheduled Report Overview window.

® No Authorization: Users cannot open the Scheduled Report Overview window.

Report Execution Scheduler e Full Authorization: Users can open the Report Execution Scheduler window (| Tools

Queries > Query Manager > Schedule }) to define and add scheduling.
® Read Only: Users can view the Report Execution Scheduler window from the Scheduled
Report Overview window.

e No Authorization: Users cannot open the Report Execution Scheduler window.
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20 Cockpit and Widget Authorizations

The following modules and functions define the cockpit and the widget authorizations.

Field Name Description

Cockpit & Widget You can grant authorizations for the different parts of the Cockpit and the Widget.

® Full Authorization: Users can access all parts specified in the Cockpit & Widget authori-
zations section.

e No Authorization: Users cannot access any part specified in the Cockpit & Widget au-
thorizations section.

i Note

These authorizations are available when the Cockpit option on the |} Administration >

System Initialization ¥ General Settings # Cockpit 4 tab is selected.

Cockpit Management e Full Authorization: Users can access the Cockpit Management - Setup window (|F Tools

> Cockpit }) for creating and maintaining the cockpits.

e No Authorization: Users cannot access the Cockpit Management - Setup window.

General Widgets e full Authorization: Users can view and access all widgets specified in the General
Widgets section.
e No Authorization: Users cannot access any of the widgets specified in the General
Widgets section.
Dashboards e full Authorization: Users can view and access the particular content in the cockpit

widget. You are also required to have the correct authorization for the content itself.

e No Authorization: Users cannot access the particular content in the cockpit widget.

Common Functions e full Authorization: Users can open and work with documents and common functions
presented in the Common Functions widget in the Cockpit
® No Authorization: Users cannot view or open the documents in the Common Functions
widget
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Field Name

Description

Open Documents

® full Authorization: Users can select and view open documents in the Open Documents
widget in the Cockpit

e No Authorization: Users cannot open or view the documents in the Open Documents
widget

i Note

Even if you have full authorization for this widget, you can view only documents under

the menu of |} Reports > Sales and Purchasing > Open Items List } for which you have
full authorization.

Messages and Alerts

e full Authorization: Users can view message and alert overviews listed in the Messages
and Alerts widget of the Cockpit

® No Authorization: Users cannot view message or alert overviews in the Messages and
Alerts widget

Browser e full Authorization: Users can view the content of the Browser widget.
e No Authorization: Users cannot view the content of the Browser widget.
Dashboard Widget ® full Authorization: Users can view and access all dashboards specified in the
Dashboards section.
e No Authorization: Users cannot access any of the dashboards specified in the
Dashboards section.
Widget Content e full Authorization: Users can view and access all widget content specified in the Widget
Content section.
e No Authorization: Users cannot access any of the widget content specified in the
Widget Content section.
Crystal Dashboard ® full Authorization: Users can view and access all dashboards specified in the Crystal

Dashboard section.

e No Authorization: Users cannot access any of the dashboards specified in the Crystal
Dashboard section.

Service Call (version for Mi-
crosoft SQL)

® full Authorization: Users can open and view performance indicators and the Service call
status with the Service Call window

e No Authorization: Users cannot open or view the Service Call window

Customer Receivables Aging
(version for Microsoft SQL)

® Full Authorization: Users can access an overall analysis of the company’s accounts re-
ceivables collection efforts and the status of key accounts with the Customer
Receivables Aging dashboard

e No Authorization: Users cannot access the Customer Receivables Aging dashboard

Sales Analysis (version for
Microsoft SQL)

e Full Authorization: Users can view the sales performance and status of customers and
employees with the Sales Analysis dashboard

® No Authorization: Users cannot access the Sales Analysis dashboard
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Field Name

Description

Cash Flow Forecast

Full Authorization:Users can open andview detailed information about your company's
incoming and outgoing cash flows

No Authorization: Users cannot open or view information about the company's Cash
Flow Forecast

Purchase Quotations (version
for Microsoft SQL)

Full Authorization: Users can open and modify the Purchase Quotation window found in
the Common Functions widget of the Cockpit

No Authorization: Users cannot access the Purchase Quotation window via the
Common Functions widget of the Cockpit

Service Call- SAP HANA

Full Authorization: Users can open and view performance indicators and the Service call
status with the Service Call window

No Authorization: Users cannot open or view the Service Call window

Sales Analysis-SAP HANA

Full Authorization: Users can view the sales performance and status of customers and
employees with the Sales Analysis dashboard

No Authorization: Users cannot access the Sales Analysis dashboard

Purchase Quotations- SAP
HANA

Full Authorization: Users can view and monitor open purchase quotations with the
Purchase Quotation dashboard

No Authorization: Users cannot view or open the Purchase Quotations dashboard

Inventory Status- SAP HANA

Full Authorization: Users can open and view the detailed confirmation status of all open
document rows for a specific item with the Inventory Status dashboard

No Authorization:Users cannot access the Inventory Status dashboard

Delivery Analysis-SAP HANA

Full Authorization: Users can open and identify whether the company delivers goods to
customers on time with the Delivery Analysis dashboard

No Authorization: Users cannot access the Delivery Analysis dashboard
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21 Report Layout API Authorizations

This module determines the authorizations for SAP Crystal Reports APIs and SAP Crystal Reports layout APlIs:

Field Name Description

Report Layout API ® Full Authorization: In the following scenarios, users have full access to the SAP Crystal
Reports data organized by the modules listed under this category in the SAP Business
One database:

o Sending API calls to APl Gateway for access to SAP Crystal Reports
o Previewing documents with SAP Crystal Reports layouts in Web Client for SAP
Business One
o Running SAP Crystal Reports in Analytics Portal in SAP Business One analytics,
powered by SAP HANA
e \Various Authorizations: When the modules listed under this category have different au-
thorizations, this authorization is displayed as Various Authorizations.
e No Authorization: Users cannot access any SAP Crystal Reports data in the aforemen-
tioned scenarios.
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22 User Authorizations

The following modules and functions define the User authorizations:

Field Nme Description

User Authorization You can grant authorizations for user-defined forms.
e Full Authorization: Users can access all forms specified in the User Authorization sec-
tion.

® Read Only: Users can view the data in all forms specified in the User Authorization sec-
tion.

® No Authorization: Users cannot access any form specified in the User Authorization
section.

i Note
To create authorizations for user—defined forms, choose | Administration # System

Initialization > Authorizations > Additional Authorization Creator 1

If you do not create any user-defined forms, the User Authorization title is displayed as
No User Authorizations.

If you select Read Only authorization for the entire User Authorization module, the au-
thorizations for its child items without the Read Only option are automatically set to No
Authorization.

XL Reporter Tools ® Full Authorization: Users can start XL Reporter from the Tools menu, to compose or edit
reports or change the XL Reporter settings.

e No Authorization: Users cannot access XL Reporter.

XL Reporter Reports ® full Authorization: Users can access and run reports that have been generated and
placed in the Main Menu by XL Reporter. To access Report Composer and Report

Designer (I Administration # Setup ¥ General ¥ Users 4), you must be defined as a
Superuser.

® No Authorization: Users cannot access reports generated by XL Reporter.
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23 System Queries Authorizations

If you want to allow or prevent your users from viewing the reports below, you need to set up authorizations for
them:

BP Bank Accounts Query

Checks for Payment in Date Cross Section Report
Customer Receivables by Customer Cross-Section
Customers Credit Limit Deviation

External Reconciliation by Due Date

External Reconciliation by Exact Amount

External Reconciliation by Sum (FC)

External Reconciliation by Trans. Number

G/L Account Location in Balance Sheet Templates

House Bank Accounts Query

Internal Reconciliation by Trans. Number

Locate Exceptional Discount in Invoice

Locate Journal Transaction by Amount Range

Locate Journal Transaction by FC Amount Range

Locate Reconciliation in Bank Statement by Row Number
Locate Reconciliation/Row in Bank Statements by Exact Amount
SE Commission by Invoices in Posting Date Cross Section
Transactions Received from Voucher Report

These reports above are System Queries, which you can access either through the Query Manager £ iconin

the tool bar or by choosing the menu |l Tools  Queries # System Queries 3.

To set up authorizations for system queries, proceed as follows:

1

Goto | Tools # Queries ¥ Query Manager 3, chooseManage Category to open the Create/Edit Categories
window, and assign the desired authorization groups to system queries.

Choose | Main Menu » Administration » System Initialization » Authorizations » General Authorizations J
to open the General Authorizations window, go to |+ Reports # Query Generator » Saved Queries - <Group

No. 1 - Group No. 20> 4and assign authorizations to users.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:

e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any

damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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contain proprietary software components of other software vendors.
National product specifications may vary.
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